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Carro elétrico de 544 CV, da Mitsubishi Motors,
encara a tradicional corrida de Pikes Peak

A tradicional competição de Pikes Peak 
teve um "silêncio" inovador. O ronco dos 
motores e a poluição dos combustíveis 
foram substituídos pela mais alta tecnolo­
gia elétrica do Mitsubishi iMiEV, que enca­
ra a prova pelo segundo ano consecutivo. 
Silencioso, mas muito potente, esse 
protótipo, baseado na versão de rua, 
é equipado com quatro motores elé­
tricos de 100 kW cada, o que equi­
vale a uma potência total de 544 CV. 
O Pikes Peak é realizado anualmente 
no Colorado, Estados Unidos, a prova 
é realizada nas estradas da montanha 
com uma série de ziguezagues e curvas 
de alta velocidade.

A largada ocorre a 2.862 metros de altitude 
e a chegada é com 4.300 m, em um per­
curso com pouco mais de 19 quilômetros 
e 156 curvas. O Mitsubishi iMiEV é o 
primeiro veículo elétrico a ser produzido 
em grande escala no mundo, desde 2009.

De lá para cá, mais de 30.000 unidades 
já foram vendidas, algumas unidades do 
Mitsubishi iMiEV já circulam por grande 
capitais, como São Paulo e Rio de Janeiro.

Tecnologia para o presente
Toda a tecnologia e o aprendizado ad­

quiridos pela equipe de engenheiros e 
mecânicos no Pikes Peaks são usados 
no aprimoramento dos carros elétri­
cos e na criação de novas e modernas 
tecnologias

Em 2012, em sua primeira participação, a 
Mitsubishi ficou com a segunda colocação 
na competição. Com todo o know-how ad­
quirido, os engenheiros puderam analisar 
com detalhes diversos dados de velocida­
de, aceleração em pista, além de consumo 
da bateria, temperatura, entre outros, que 
foram fundamentais no aperfeiçoamento 
do veículo. Com isso, e após mais de um 
ano de preparação e desenvolvimento, 
surgiu a segunda geração do iMiEV Evo­
lution, com um motor mais potente e 
novos componentes.

O iMiEV Evolution II é equipado com a 
tração 4x4 (S-AWC), sinônimo da mais 
alta tecnologia em todo o mundo. O 
modelo recebeu uma série de melhorias, 
como as novas baterias de alta capacidade, 
quatro motores elétricos que geram 544 
CV de potência, controles de tração e 
estabilidade (AYC eASC) que não deixam 
o veículo sair da trajetória correta, além 
dos freios com ABS. Tudo isso agregado 
a uma estrutura leve e aerodinâmica, que 
possibilita uma melhor performance nas 
156 curvas da montanha.

Manômetros de Referência de Pressão,
da Fluke Calibration

A Fluke Calibration apresenta os Manô- 
metros de Referência de Pressão - Série 
2700G. Com nove modelos fáceis de 
usar, resistentes e de alta confiabili- 
dade, são ideais para calibração em 
laboratórios de pressão e oficinas de 
instrumentação que precisem de uma 
solução de medição da pressão confiável 
e altamente exata.

A Série 2700G pode ser conjugada com 
os Kits de bombas manuais de pressão 
Fluke 700PTPK e 700HTPK para uma 

completa solução de testes portáteis 
de pressão, ou com as Bombas Com­
parativas da Série P5500 desta mesma 
empresa, oferecendo assim uma solução 
completa para bancadas de calibração.

Os manômetros proporcionam uma me­
dição de pressão exata com variações de 
faixa de 100 kPa (15 psi, 1 bar) a 70 MPa 
(10.000 psi, 700 bar).

A incerteza da medição é a melhor de 
sua classe, com 0,02% FS. O manômetro 
padrão vem com um cabo USB que pode 

ser usado para comunicação com um 
computador, ou como fonte universal 
para alimentação do intrumento.

A Série 2700G inclui um adaptador % 
NPT fêmea para % BSP macho, um adap­
tador % NPT fêmea para M20X.15, cer­
tificado de calibração rastreado, um cabo 
de comunicação USB e fonte universal. 
O manômetro pode ser usado em con­
junto com o software Fluke COMPASS 
para gravação automática dos dados da 
calibração de pressão.
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Protek Devices lança sua primeira família de fusíveis “chips”
eletrônicos para sobrecorrente

A Protek Devices apresentou uma 
família de fusíveis chips eletrônicos 
para sobrecorrente que se soma à 
extensa disponibilidade de linhas de 
produtos de sobretensão da empresa. 
Agora, a companhia pode fornecer às 
fabricantes de design de eletrônicos 
(EDM) uma única fonte de soluções 
avançadas e de baixo custo de prote­
ção de circuitos. Os novos fusíveis de 
sobrecorrente cobrem uma infinidade 
de aplicações, tais como telecomuni­
cações, informática, eletroeletrônicos 
e muito mais.

Os novos fusíveis de sobrecorrente em 
dispositivo de montagem em superfície 
(SMD) consistem de uma variedade 
de tipos e tamanhos. Os números de 
peça para o pacote 0603 são PF0603F, 
PF0603S e PF0603H. O PF0603F é um 

fusível de ação rápida. O PF0603S é 
um fusível de ação lenta. E o PF0603H 
é um fusível de alto inrush.

O pacote 0603 é ideal para TVs LCD, 
câmera digital, DVD e Blu-ray players, 
câmeras de vídeo e videogames. Tam­
bém é ideal para power-over-Ethernet, 
discos rígidos e outros dispositivos de 
consumo.

Os números de peça 1206 são PF1206F, 
PF1206S e PF1206H. O PF1206F é um 
fusível de ação rápida. O PF1206S é um 
fusível de ação lenta. E o PF1206H é um 
fusível de alto inrush. O pacote 1206 é 
ideal para smartphones, DVD e Blu-ray 
players, consoles de jogos e reprodu­
tores de música digital. Ele também é 
ideal para dispositivos GPS, sistemas de 
áudio, fontes chaveadas e carregadores 
e scanners. Além disso, o pacote 1206 

é adequado para equipamentos de 
infraestrutura de telecomunicações e 
modems DSL/de cabo.

"Há décadas, lideramos o fornecimento 
de soluções avançadas e de custo-be­
nefício em proteção de circuitos de so- 
bretensão e os nossos clientes também 
têm nos perguntado sobre as soluções 
de proteção de sobrecorrente", disse 
Rocky Kansal, presidente da Protek 
Devices. "Atendemos agora os pedidos 
de nossos clientes com estes fusíveis de 
ação rápida, queima lenta (slow blow) e 
alto inrush. Então, estamos oferecendo 
agora uma única fonte para as EDMs 
adquirirem todos os seus componentes 
de proteção de circuitos de sobreten- 
são e sobrecorrente. Continuaremos 
também expandindo e inovando essa 
linha de fusíveis chips."

Produtos
Integrated Biometrics apresenta Sherlock, o menor, 
mais leve e fino Sensor Appendix F Mobile ID

A Integrated Biometrics, LLC (IB) 
anunciou outro ineditismo tecnológico 
com a certificação pelo FBI, dos Estados 
Unidos, da sua novíssima tecnologia 
para impressões digitais. A equipe de 
desenvolvimento da IB criou o novo 
produto usando a tecnologia paten­
teada da empresa, Light Emitting Sensor 
(LES), juntamente com um transistor 
de película fina (TFT).
A tecnologia LES utiliza uma película 
de polímero altamente elaborada, 
interagindo com propriedades espe­
cíficas da pele humana para imagens 
luminescentes de impressões digitais.A 
TFT captura a imagem no padrão 500 
PPI, exigido pelo FBI.
A combinação da tecnologia LES e do 
transistor de película fina (TFT) permite 
reduções de peso e imagem de até 95%, 
quando comparada a outros produtos 
servindo ao mesmo propósito.
A IB fornece sensores de impressão 
digital customizados para mercados que 
exigem soluções biométricas Appendix

F ou PIV071006 e, diferentemente 
de outras tecnologias biométricas de 
impressão digital usadas com frequência, 
ela é capaz de alcançar a mais alta qua­
lidade de imagens sem comprometer a 
espessura e o tamanho total do aparelho. 
Esta capabilidade única produziu o pri­

meiro sensor do mundo com base em 
TFT a alcançar a certificação de identi­
dade móvelAppendix F Mobile ID, do FBI. 
As tecnologias estão sendo usadas 
para produzir os mais finos, menores 
e leves sensores biométricos Appendix 
F Mobile ID.
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Amper prepara a entrega 
de um novo equipamento

A Amper Programas recebeu pedido da 
empresa francesaThales Communications 
& Security para fabricação de 500 unida­
des para o Exército Francês do seu novo 
produtoW@tcher, destinado ao mercado 
internacional.

O W@tcher é um equipamento portátil 
de características militares, que permite o 
controle remoto das rádios táticasVHF e 
HF sem fio, via bluetooth. Com a sua tela 
tátil, que fica posicionada no antebraço 
como se fosse um relógio, oferece um 
controle de todos os parâmetros de 
configuração das rádios, além de outros 
serviços como SMS ou FFI (identificação 
de pessoas confiáveis ou inimigas).

Por meio dele, os chefes das unidades po­
derão se conectar de modo autônomo, 
tanto com a rádio do veículo quanto com 
um rádio transportado por um soldado 
de sua equipe, com bluetooth. O acesso 
é realizado de modo fácil graças a sua 
interface gráfica simplificada e intuitiva.

Uma das características mais importantes 
deste novo dispositivo é permitir maior 
autonomia e liberdade de movimento aos 
soldados, que podem acessar as principais 
funcionalidades do rádio por meio de um 
equipamento leve e compacto, desenhado 
para trabalhar em condições severas. 
Desse modo, foi possível responder uma 
antiga demanda dos exércitos que, até 
hoje, tinha sido difícil atender no que diz 
respeito à ergonomia para gerenciamento 
das comunicações num entorno tático.

O W@tcher foi elaborado pela Amper 
Programas seguindo especificações 
conjuntas da Thales, o que vai permitir 
adicionar futuros aplicativos direcionados 
à melhoria do combatente.

O início da operação deste novo equipa­
mento permite àAmper seguir mantendo 
a sua liderança na Espanha no âmbito das 
radiocomunicações militares, área que 
nos últimos anos tem se tornado um dos 
pilares da Divisão de Defesa do Grupo.

Laser de alta precisão,
sem contato

Um laser sem contato para medição rápida, 
de alto desempenho, foi lançado pela 
AMETEK Solartron Metrology. A nova 
unidade de triangulação a laser Orbit® 
LTH oferece leituras de 0,02 F.S. (Full 
Scale) em intervalos de medição de 2 ou 
10 mm, produzindo uma precisão de até 
0,05 pm com o passo de 2 mm. O laser 
pode ser conectado em rede com até 
150 sensores diferentes com o sistema 
de medição digital Solartron Orbit 3.

Entre as aplicações destacam-se a medi­
ção em alto volume para o controle da 
qualidade de produtos metálicos e plás­
ticos que poderiam ser danificados por 
instrumentos de medição com contato.

Os circuitos de controle automático de 
ganho do sensor ajustam a potência de 
acordo com o retorno do material, ofe­
recendo leituras melhores em superfícies 
diferentes.

Há várias saídas disponíveis, como USB, 
Ethernet, TCP, RS232 e Modbus.

Produtos
Roteadores TP-LINK promovem liberdade e qualidade de 
conexão para usuários de internet

Devido à evolução tecnológica dos 
últimos anos, cresce o número de 
dispositivos que podem acessar a 
internet, bem como a qualidade de 
conteúdos audiovisuais e interação 
social para compartilhamento de 
informações. Os consumidores fazem 
uso simultâneo de smartphones, 
tablets e notebooks, além de terem 
nas residências televisores do tipo 
“smart” e até mesmo geladeiras 
conectadas. Assim, nada melhor que 
estes aparelhos estejam interligados 
em um único dispositivo inteligente: 
os roteadores de acesso à internet 
para uso doméstico (ou corporativo). 
Quem dá as dicas sobre o melhor 
produto a ser utilizado é o cliente, 
conforme a necessidade de solução 
para conectar computadores, dispo­
sitivos portáteis e eletroeletrônicos 
que têm conexão à internet. Caso a 

dificuldade seja montar uma rede sem 
fio com grande alcance, a TP-LINK 
oferece tecnologias que permitem a 
interconexão de diferentes roteado­
res para que se comuniquem entre 
si, sem precisar de fios. Trata-se do 
sistema de distribuição de sinal WDS, 
no qual a TP-LINK foi a primeira a 
oferecer esta tecnologia no mercado 
brasileiro. Mas, se a demanda é por 
velocidade e facilidade de acesso 
para compartilhamento de conte­
údos, acesso a redes sociais, jogos 
online ou filmes em alta definição, as 
soluções Gigabit Ethernet oferecem 
desempenho de até IGbps, que per­
mitem que tudo isso seja executado 
simultaneamente sem “gargalos” ou 
travamentos.
Potentes e cheios de tecnologia, os 
roteadores da TP-LINK tem design 
agradável e moderno, oferecem

suporte à segurança na transmissão 
de dados com o recurso de Confi­
guração de Segurança Rápida ( Quick 
Security Setup), que estabelece auto­
maticamente uma conexão segura ao 
clique de um botão, o que permite 
manter a privacidade dos usuários e 
da rede protegidas. Outra vantagem 
é o longo alcance, para desfrutar do 
sinal em qualquer lugar.
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Sandisk apresenta o cartão MICROSDXC 
de 64 GB mais rápido do mundo

A SanDisk Corporation, líder mundial 
em soluções de armazenamento de 
memória flash, anunciou os cartões de 
memória UHS-I SanDisk Extreme® 
microSDHCT e microSDXCT, ideais 
para usuários que desejam uma rápida 
memória expandida para os mais re­
centes smartphones, tablets e câmeras. 

"O cartão SanDisk Extreme microSDXC 
permite aos usuários tirar mais proveito 
de seus dispositivos," afirmou Susan Park, 
diretora de marketing de produto e vare­
jo da SanDisk. "Nossos cartões microSD 
de alto desempenho e alta capacidade 
permitem aos consumidores aprovei­
tarem a alta qualidade em vídeo HD e 
recursos de imagem nos mais recentes 
smartphones, tablets e câmeras de ação."

O cartão microSDXC é equipado com as 
mais rápidas velocidades disponíveis no 
mercado, com até 80 MB/seg de velocida­
de de leitura e até 50 MB/seg de gravação, 
permitindo um desempenho mais veloz a 

cada foto, rápida transferência de dados 
e arquivos, excelente ação em fotografias 
e modo de disparo contínuo. Além disso, 
esse cartão de memória é a escolha ideal 
para dispositivos AndroidT com 64 GB 
de capacidade, oferecendo uma atualiza­
ção de armazenamento instantânea para 
capturar e preservar dados.

Compatível também com as mais recen­
tes câmeras e gravadoras Full HD para 
esporte e ação, a velocidade do cartão 
permite aos usuários capturar fotos e 
vídeos incríveis. A classificação de gra­
vação em vídeo com Velocidade Classe 
10 e Velocidade UHS de Classe 1 (U1) 
garante aos usuários aproveitarem um 
desempenho melhor do que dos car­
tões de memória comuns para Full HD e 
até mesmo para gravação e reprodução 
dos vídeos em 4K HD.

"A maioria dos smartphones de ponta 
possuem processadores de quatro nú­
cleos (quad-core) de alta velocidade, que

oferecem conteúdo e aplicativos Full 
HD a displays externos maiores e com 
alta resolução," disse Stuart Robinson, 
diretor de serviços de tecnologias de 
componentes para telefones móveis 
e análise estratégica. "Tais aplicativos 
exigem espaço de banda de memória 
maior, o que é ideal para o cartão San­
Disk Extreme microSDXC, a solução 
de memória microSDXC mais rápida 
do mundo."

Os cartões SanDisk Extreme microSDHC 
e microSDXC UHS-I são construídos e 
testados em condições extremas. Eles 
são à prova d'água, à prova de choque 
e resistentes a raio-X.



Redes de comunicação 
usadas nas aplicações de 
Controle de

Guilherme Kenji Yamamoto
Renan Airosa Machado de Azevedo
National Instruments

Movimento
A concorrência global está pressionando 

os fabricantes de dispositivos ou máquinas 

a fornecerem equipamentos com alto rendi­

mento e custos operacionais reduzidos. Os 

crescentes custos de energia e a consciência 

ambiental estão levando os engenheiros a 

desenvolverem projetos com um menor con­

sumo de energia. Devido a isso, fabricantes 

de equipamentos têm mudado a concepção 

de máquinas simples para soluções com 

múltiplas finalidades através da adoção de 

modernos sistemas de controle, algoritmos 

sofisticados, integração eletrônica high-end 

e tecnologias de comunicação com estruturas 

mecânicas.

O
Controle de movimento é 
essencial para os sistemas 
mecatrônicos. Para otimizar 
os sistemas mecânicos, os 
fabricantes de máquinas muitas vezes 

substituem peças mecânicas com soluções 
eletrônicas. Um exemplo é a eliminação dos 
eixos rígidos para executar operações de 
camming. Estes eixos são substituídos por 
uma combinação de drives e motores que 
dependem de um software de controle 
para fornecer funcionalidade ao camming. 
Tais sistemas e dispositivos são mecanica­
mente mais flexíveis, mais fáceis de manter 
e menores. No entanto, estas máquinas 
também contêm mais componentes ele- 
trônicos que requerem um controle com­
plexo e determinístico e de comunicação 
confiável.Veja as figuras 1 e 2.

Em um sistema típico, o controlador 
de movimento tem a maior parte da carga 
de maior complexidade do sistema. Ao 
manipular a sincronização de múltiplos 
eixos, esses controladores oferecem 
engrenagens e funcionalidades camming, 

bem como todas as características de 
segurança adicionais, tais como limites de 
switches, habilitação de driver e parada de 
emergência. Além disso, o controlador de 
movimento ainda precisa fornecer as fun­
ções tradicionais e executar os algoritmos 
de controle para máximo desempenho e 
eficiência.

Tendências de Tecnologia 
de Controle de Movimento

Tradicionalmente, as aplicações de 
controle de movimento utilizam um con­
trolador de movimento dedicado e um con­
trolador separado para controlar sistemas 
mais complexos. O aumento de desempe­
nho dos controladores de automação de 
hoje, como controladores programáveis 
para automação ou controladores lógicos 
programáveis, está alimentando a tendência 
de integrar a funcionalidade do controlador 
de movimento diretamente ao controlador 
de automação e executá-lo como uma ta­
refa de alta prioridade entre outras tarefas 
de automação.

F1. Sistema tradicional, com 
componentes mecânicos.
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Desde o início de 1980, sistemas de 
automação têm sido baseados em barra­
mentos digitais para realizar tarefas como 
transferência de dados de processo e de 
comunicação industrial. Comparados com 
o barramento analógico, eles são mais 
confiáveis e robustos, especialmente para 
a comunicação através de longas distâncias. 
Além disso, as redes digitais simplificam 
a fiação, pois permitem conectar vários 
elementos em série ao invés de ligar cada 
elemento individualmente. Isso resulta em 
um cabeamento significativamente mais 
barato e mais fácil de manter nos sistemas.

Devido aos requisitos de desem­
penho, por muitos anos a indústria 
de movimento teve uma abordagem 
diferente e se conectou a drivers via 
barramento analógico, ou barramento 
de movimento específico. Este esquema 
de comunicação adicional aumentou a 
complexidade do sistema global. Com o 
driver digital de alta performance e com 
o barramento digital, agora, é possível 
simplificar a arquitetura do sistema usan­
do o mesmo barramento para controle 
de movimento e controle de dados do 
processo e, ao mesmo tempo, obter me-

F2. Sistemas atuais com vários 
eixos sincronizados.

lhoria significativa de desempenho com 
as vantagens do barramento digital como 
EtherCAT, CANopen, Profibus, Ethernet 
POWERLINK, ou SERCOS.

Especialmente em aplicações que 
executam controle distribuído de movi­
mento com multieixos, os barramentos 
digitais oferecem uma série de vantagens. 
Eles proporcionam maior flexibilidade e 
permitem o desenvolvimento de sistemas 

distribuídos com poder de processamento 
e tomada de decisão até o nível dos dri­
vers. Com as normas comuns, os clientes 
podem facilmente combinar sistemas 
de diferentes fornecedores e escolher 
a melhor solução para as suas tarefas 
individuais.

Ao usar drives digitais que se co­
municam por barramento digital, for­
necedores e fabricantes são capazes de k



criar unidades que usam o barramento 
digital para a troca de dados não só de 
controle, mas também transferir as in­
formações de status ou um conjunto de 
parâmetros. Uma das grandes perguntas 
feitas pelos clientes de automação é 
“qual o protocolo ideal para aplicações 
de automação industrial em geral e apli­
cações de movimento em particular?”

Os protocolos mais comuns baseados 
em Ethernet para aplicações de movimen­
to são os seguintes:

• EtherCAT
• SERCOS II/III
• CANopen
• Modbus IDA
• PROFINET
• PROFIBUS
• EtherNet/IP
• Ethernet POWERLINK
Devido ao grande número de normas 

e protocolos de diferentes barramentos, 
os clientes precisam ter certeza de que os 
componentes que desejam usar fornecem 
uma interface direta. Isto significa que os 
fabricantes são muitas vezes obrigados 
a desenvolver várias versões diferentes 
de seus componentes. Isso adiciona um 
custo de desenvolvimento e o obriga 
a participar de várias organizações de 
normatização. Com seus esforços para 
fornecer sistemas abertos, empresas 
como a National Instruments incorporam 
interfaces com as normas de barramentos 
e vários protocolos.

F3. Estrutura da rede Ethernet 
com EtherCAT.

Apesar de oferecer suporte para os 
principais protocolos industriais e for­
necimento de conectividade para todas 
as redes de padrão industrial, a National 
Instruments escolheu a EtherCAT como 
protocolo de comunicação para aplica­
ções de controle de movimento.

Tecnologia EtherCAT para 
aplicações de controle de 
movimento

EtherCAT (Ethernet Control Auto­
mation Technology) é um protocolo de 
comunicação industrial para Ethernet 
determinística de alta performance. Ele 
é uma extensão do padrão Ethernet 
IEEE 802.3 para transferir dados com 
sincronização de tempo determinísti- 
co e preciso. Dirigido pelo EtherCAT 
Technology Group, este padrão aberto 
foi publicado como parte da IEC 61158 
e é comumente usado em aplicações 
para projetos de máquinas e controle 
de movimento.

EtherCAT implementa um master/ 
slave sobre a arquitetura de cabeamento 
Ethernet padrão. Os EtherCAT master 
da National Instruments consistem 
em controladores de tempo real, com 
duas portas Ethernet, tais como NI 
CompactRIO, PXI e controladores 
industriais. Cada slave NI também 
contém duas portas que permitem 
encadeamento a partir do controlador 
master.

O protocolo EtherCAT transporta 
dados diretamente dentro de um fra­
me Ethernet padrão, sem alterar sua 
estrutura básica. Quando o contro­
lador master e os dispositivos slaves 
estão na mesma sub-rede, o protocolo 
EtherCAT apenas substitui o Proto­
colo Internet (IP) no frame Ethernet. 
Observe a figura 3.

Os dados são transmitidos entre 
master e slaves, sob a forma de ob­
jetos de processo de dados (PDO). 
Cada PDO tem um endereço para um 
slave particular ou de vários slaves, e 
esta combinação de “dados e endere­
ços” (mais o contador de validação) 
torna-se mensagens EtherCAT. Uma 
estrutura Ethernet pode conter várias 
mensagens, e várias estruturas podem 
ser necessárias para conter todas as 
mensagens requeridas em um ciclo de 
controle.

Desempenho em 
alta velocidade

A EtherCAT é projetada para atin­
gir alto desempenho e alta número de 
canais para aplicações simples, como 
de controle, porque o slave pode ler e 
escrever na mesma estrutura de rede, 
mas a EtherCAT é otimizada para E/S 
descentralizadas. Além disso, o pro­
cessamento do protocolo completo 
tem lugar dentro do hardware e é, 
portanto, independente do tempo de 
execução de pilhas de protocolo, do 
desempenho da CPU, ou da implemen­
tação de software.

Temporização e 
Sincronização

Outro fator para alcançar o de­
terminismo nas redes é a responsa­
bilidade do controlador master em 
sincronizar com todos os dispositivos 
slaves ao mesmo tempo em que usa 
os clocks distribuídos. De todos os 
dispositivos slaves, um deles deve 
conter o clock master que sincroniza 
o clockdos outros dispositivos slaves. 
Para a implementação da NI, o primei­
ro dispositivo slave é designado com o 
clock master, e o controlador master 
envia uma mensagem de sincronização 
especial para ler o clock master em 
cada ciclo de scan. Esta mensagem, em
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F4. Configuração Gráfica de Eixos através 
_____________ de projetos com LabVIEW.

seguida, atualiza e realinha os clocks em 
todos os outros dispositivos slaves.

Sincronização precisa é particular­
mente importante nos casos em que 
os processos amplamente distribuí­
dos exigem ações simultâneas, como 
no movimento coordenado entre 
os eixos de movimento. A NI utiliza 
time stamps para medir a diferença 
de tempo entre a saída e o retorno. 
Desta forma, o atraso de propagação é 
calculado entre os nós, e uma precisa 
sincronização (menos de 1 ps) pode 
ser alcançada pelo ajuste exato dos 
clocks distribuídos.

Devido ao desempenho de alta 
velocidade e ao timing reduzido para 
recursos de sincronização, o EtherCAT 
é uma solução ideal para aplicações 
distribuídas em rede ou controle de 
movimento, onde um poderoso con­
trolador atua em tempo real, como 
o master EtherCAT e executa o apli­
cativo de controle de movimento de 
comunicação externa, distribuído nas 
unidades slaves pelo EtherCAT.

Servomotores e 
drivers EtherCat

Os servo-drivers EtherCAT da NI 
combinam performance com flexibi­
lidade, escalabilidade e potência para 

atender os requisitos de desempenho 
exclusivo de quase todas as aplicações 
a partir de torques básicos e aplicações 
para controle de velocidade de movi­
mento de multieixos, usando progra­
mação gráfica com o NI LabVIEW e o 
Módulo NI LabVIEW SoftMotion.

Os cabos Ethernet-padrão simplifi­
cam significativamente o cabeamento e 
a capacidade de encadear até 128 eixos. 
Um controlador de alto desempenho em 
tempo real permite a configuração de 
um sistema distribuído de controle de 
movimento dentro de minutos. Usando 
o projeto do LabVIEW para configurar 
e validar o sistema de controle de mo­
vimento simplifica-se a configuração e a 
programação gráfica. Com as funções de 
alto nível de movimento ou a proprieda­
de de chamar nós API, os clientes podem 
implementar aplicações de movimento 
personalizadas através da facilidade de 
uso da programação gráfica. Atente para 
a figura 4.

Os controladores de tempo real 
da NI, servoacionamentos AKD Ether­
CAT, NI LabVIEW e o NI LabVIEW Sof- 
tMotion Module EtherCAT tornaram a 
tecnologia acessível para que clientes 
possam implementar aplicações dis­
tribuídas em rede ou para controle 
de movimento. E
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Soldando SMDs com
Invólucro QFN

Este artigo complementa o curso rápido 

Retrabalho (rework) em Componentes SMD, 

anteriormente publicado nas revistas Saber 

Eletrônica 443, 444 e 445. O
título acima está parcialmente cor­
reto. O termo certo é retrabalhan- 
do, que vem do inglês rework. Como 
rework você pode encontrar muita 
informação boa em sites de língua inglesa, 

facilmente. Mas o retrabalho, no Brasil, ain­
da é uma palavra pouco utilizada, e escrevi 
“soldando” por ser mais comum e simples.

Este artigo vem complementar uma 
série de três que fiz, nas edições nos 443, 
444 e 445, que ainda, surpreendentemente, 
são muito atuais e com bom conteúdo para 
quem deseja se aprimorar em retrabalho 
desde o seu início. Já naquela época esses 
artigos eram inovadores e, por incrível que 
pareça, foram baseados em treinamentos 
que fiz na LG Amazônia em Taubaté, oito 
anos antes!

Isso demonstra algumas coisas, a pri­
meira é que a Revista Saber Eletrônica está 
publicando artigos de nível bom a ótimo, e 
em consonância com as necessidades das 
indústrias, mercado de trabalho e escolas 
técnicas, e com uma visão e estratégia de 
futuro muito boas. Já pensou uma empresa 
de tecnologia saber oito anos antes sobre 
o futuro? O mais incrível é que as indústrias, 
escolas técnicas, fabricantes e distribuidores 
de ferramentas para retrabalho em SMD 

ainda não se deram conta disso! Ou muitos 
pontos desta linha se unem, ou não haverá 
profissionais qualificados a tempo para aten­
der as necessidades das indústrias!

Mas, tratemos agora da parte mais 
prática do Retrabalho em Componentes 
com Invólucro QFN. Começando pelo 
que é óbvio, vamos abrir a caixa preta dos 
QFN pela descrição de sua sigla. Aliás, QFN 
ainda por cima não é uma sigla “completa”, 
digamos assim. É a abreviatura de uma sigla 

e, para complicar mais um pouco, não é uma 
sigla exclusiva de um tipo de invólucro, mas 
de toda uma família de invólucros que está 
dispersa e continuamente evoluindo nas 
indústrias fabricantes de chips.

O significado completo da sigla é Quad 
Fiat No-Lead - (QFN), ou seja, é uma família 
de invólucros de circuitos integrados ou de 
módulos, do tipo plano, com conexões em 
seus quatro lados, mas sem terminais. Pode 
(ou não) possuir um dissipador com plano­
-terra sob o chip. Nas figura 1 mostramos 
alguns invólucros desta família.

Há ainda uma pequena variação mecâni­
ca nos invólucros QFN, que são os pDFN. 
A definição de sua sigla é Micro Dual Flat 
No-Lead, ou seja, é muito semelhante à filo­
sofia de invólucro com a família QFN, mas

Para você que gostaria de saber mais 
sobre o tema, acesse:

•  
doc/app_note/AN1902.pdf

www.freescale.com/files/analog/

•  
Intersil/documents/tb38/tb389.pdf
www.intersil.com/content/dam/

• www.digimimic.com/docs/QFN- 
Soldering.pdf

F1. A família dos 
invólucros QFN.

F2. A família dos 
invólucros pDFN.
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há duas diferenças significativas: a primeira 
é o “micro”, os pDFN são ainda um pouco 
menores que os QFN; e a segunda diferença 
é a distribuição das conexões - nos pDFN as 
conexões são dispostas em apenas dois lados 
do chip. Este invólucro é muito utilizado em 
circuitos integrados e semicondutores mais 
simples em termos de conexões externas. 
Observe na figura 2 os invólucros citados.

Repare que nessas figuras, tanto os QFN 
quanto os pDFN são apresentados com e 
sem dissipador aterrado. Este dissipador é a 
área metálica debaixo do CI. Observe também 
as diferenças das duas partes de família QFN.

Para complicar mais um pouco há dois 
tipos de QFN, considerando a sua área e 
formato dos pontos de soldagem. São elas: a 
do tipo E e S. Os invólucros em QFN do tipo 
E são mais simples de serem retrabalhados 
do que os do tipo S, em princípio.

Atente para as figuras 3 e 4.Veja que no 
tipo E a área de soldagem se distribui sobre 
um formato em L, aproveitando a área lateral 
do CI. No tipo S isso não acontece e o CI só 
possui a área inferior para soldagem.

A família QFN é composta normalmente 
de componentes quadrados. Há exceções 
mas a grande maioria é fabricada em formato 
quadrado: 16x16, 32x32 terminais, etc. Pode­
ria se questionar esta característica pelo fato 
de serem Quad Flat, mas flat significa plano. 
Há muitos (T)QFP que não são quadrados, 
e sim retangulares.

Como curiosidade, na figura 5 apresen­
tamos um diagrama esquemático interno de 
um CI em invólucro QFN em corte para 
podermos observar suas partes e conexões.

Veja que a medida da altura do CI dese­
nhado é de 0,9 mm!

QFN, as dimensões físicas
É muito simples falarmos desta família 

de invólucros com imagens aumentadas, 
tratando de retrabalho, soldagem, etc., sem 
considerar suas dimensões físicas reais. Então 
vamos apresentar alguns desenhos com suas 
dimensões ampliadas, mas, desta vez com 
suas medidas dimensionais. Acompanhe nas 
figuras 6 e 7.

Como curiosidade, observe na figura 
8 uma comparação com um CI em QFN.

O CI em QFN e as 
medidas do layout

Para fazermos um retrabalho temos que 
analisar tanto o chip em si e suas dimensões

F3. QFN 
tipo E.

F4. QFN 
tipo S.

F5. Desenho esquemático em 
corte de um CI em QFN.

2013 I Julho/Agosto I SABER ELETRÓNICA 471 I 15



quanto o seu layout. Isso para termos uma 
ideia do espaço disponível para introduzir­
mos o ferro de solda e termos uma boa 
sensibilidade da inclinação necessária em 
função do tipo de ponta de ferro de solda 
que estamos utilizando, da geometria do 
chip e do espaço disponível para a trans­
ferência de calor suficiente para que seja 
derretida a solda.

A recomendação de layout mais de­
talhada que encontrei está apresentada 
parcialmente na figura 9.

Traduzindo e interpretando os itens 
da tabela 1 temos as palavras: versão 
(version), número de pinos (number of 
pins), espaçamento entre terminais (pitch), 
comprimento dos terminais de soldagem 
(Lead Pad Length), largura dos terminais de 
solda (Lead Pad Width), largura do terminal 
de dissipador (Thermal Pad Witdh), compri­
mento do terminal de dissipador (Termal Pad 
Length), comprimento máximo do terminal 
do CI (Maximum Component Lead Length) e 
largura máxima do terminal do CI (Maximum 
Component Lead Width).

Com estas informações podemos dizer 
que: temos um espaço disponível de pad 
para fora do CI de 0,17 mm (comprimento 
máximo do terminal do CI - comprimento 
dos terminais de soldagem: 0,92 - 0,75). 
Esta medida de 0,17 é em toda a volta do 
CI, considerando-se ainda que esteja muito 
bem posicionado! Por causa disto tem tanto 
profissional que não gosta de SMD, é um 
trabalho muito preciso e delicado que exige 
muita concentração. Esta informação pode 
ser vista melhor na figura 10.

O retrabalho, parte 1: 
Dessoldando

É muito mais fácil e rápido dessoldar 

CI em QFN com o auxílio de um pré­
-aquecedor (pre-heater). Este pré-aque­
cedor pode ser feito por você mesmo, 
inclusive. Quem sabe, se escreveremos 
um artigo sobre isso?

O importante é que para a soldagem 
de SMDs, como por exemplo estes CIs, o 
ideal é obedecer uma curva específica de 
evolução da temperatura em função do 
tempo, com a finalidade de aumentar sua 
vida útil e da placa (figura 11). Lembre­
-se que não sabemos ainda se o chip 
está funcional ou não, somente vamos 
saber disso quando o substituirmos por 
um novo ou ressoldarmos o antigo. São 

duas estratégias de solução de problemas. 
Uma focada no mau contato de solda, e a 
segunda no chip.

A pergunta agora é: como vamos fazer 
esta curva de temperatura x tempo “na 
mão”, com um soprador de temperatura 
controlada e um pré-aquecedor? Ou até 
mesmo sem o pré-aquecedor? Como é mais 
comum, a reposta vem de conhecermos 
melhor nosso equipamento.

Conhecendo melhor seu 
soprador térmico

Há muitos tipos de sopradores tér­
micos no mercado. Para você conhecer 
melhor o SEU soprador, sugiro que faça 
um ensaio interessante. Para este ensaio 
você vai precisar de um termômetro com 
termopar, PT100 ou semelhante, um pedaço 
de madeira com marcação de 10 em 10 mm 
e o seu soprador. Ligue o soprador, ajuste 
sua temperatura para o início de sua escala, 
caso não esteja marcada em °C, depois 
de alguns segundos que a temperatura se 
estabilizou, monte uma tabela com esta 
posição, a distância do soprador ao sensor 
de temperatura e a temperatura que foi me­
dida. O soprador que tenho em mãos é um 
simples de marca muito boa, este modelo 
não possui escala em °C. A escala é de 1; 
1,5; 2; 2,5; até 6. Veja a tabela 2.

Em primeiro lugar anote a graduação da 
escala em que foi ajustada e, com o sensor 
de temperatura, meça a temperatura do 
jato de ar quente considerando as distâncias 
aproximadas. Por exemplo, no primeiro traço 
principal da escala, depois de estabilizado o 
aquecimento, meça a temperatura a uma dis­
tância de 40 mm, anote a medida, posicione 
o sensor a 30 mm e meça a temperatura 
novamente, anote a medida, e repita o pro­
cesso por quatro ou cinco pontos na escala 
do potenciômetro do soprador.

Feito isso, procure um ponto de ajuste 
de temperatura na escala do seu soprador 
no qual apenas variando a distância do bico 
até o sensor você consiga reproduzir a curva 
de aquecimento ideal de retrabalho, sem 
mexer no controle de potência, variando 
somente a distância.

Caso haja vários componentes sensíveis 
ao calor na região de retrabalho do QFN, 
é necessário protegê-la com fita adesiva 
de Kapton (amarela). Coloque pedaços 
pequenos de fita no entorno do CI QFN, 
protegendo esta região, principalmente 

do fluxo de ar quente. Estas fitas também 
atuam como “espelhos”, refletindo o infra­
vermelho do ar quente.

Agora, ligue o pré-aquecedor sob a área 
do componente QFN numa temperatura 
que pode variar de 100 a 120 °C depen­
dendo do tamanho das trilhas e das áreas 
de dissipação de calor na placa. Aguarde 
alguns segundos para a estabilização da 
temperatura.

Aproxime lentamente o bico do sopra- 
dor observando uma distância de 50 a 60 
mm, aguarde 10 a 15 segundos, aproxime 
o bico do soprador tendo sempre como 
referências a curva de aquecimento do chip 
e a tabela de aquecimento do soprador.

Com a pinça na mão, lentamente apoie 
sua ponta na lateral do chip e veja se ele está 
solto, “flutuando” na solda. Dê um super 
leve toque no chip e veja se isso ocorre. Se e 
somente se, o chip estiver nestas condições, 
remova-o com muita calma pegando-o com 
a pinça pelo seu lado superior. Caso contrá­
rio, se o chip ainda está com a solda pouco 
aquecida, aproxime novamente o bico do 
soprador, cuidado, siga sempre a tabela e o 
gráfico! Remova o chip quando for possível.

Como não sabemos com certeza se o 
chip está com problemas ou se é a qualidade 
da solda, coloque-o sobre a caixa metálica 
do soprador o mais rápido possível.

Partindo da ideia que o chip em QFN 
está queimado, vamos para a próxima etapa: 
a sua substituição.

O retrabalho, parte 2: 
Soldando um QFN

Para soldarmos o mesmo CI vamos 
começar pela limpeza da PCI. Aplique um 
pouco de fluxo. Use um pedaço de malha de 

1 ou 1,5 mm de largura, então posicione a 
malha sobre a solda a ser removida e encoste 
a ponta do ferro sobre ela. Muito cuidado, 
faça isso sem pressionar a ponta do ferro 
contra a malha, arranhando o PAD de solda. 
Dependendo da força aplicada com o calor, o 
PAD se solta facilmente da placa. Terminada 
a limpeza da placa, vamos estanhar o chip.

Um chip novo em QFN normalmente 
não possui solda suficiente para a sua solda­
gem, isso ocorre com os BGAs. Então quem 
utiliza no ferro de solda uma ponta-faca, leva 
vantagem agora, pois este preenchimento 
de terminais com a solda é muito facilitado. 
Ajuste sua estação de solda para uma tem­
peratura um pouco acima da temperatura

16 I SABER ELETRÓNICA 471 I Julho/Agosto I 2013



Necessita Potência?
de fusão da solda, normalmente se você es­
tiver soldando com solda de baixo ponto de 
fusão esta temperatura é em torno de 180 
°C e o ajuste fica em até 220 °C, na ponta 
isolada, com a temperatura estabilizada.

Siga este procedimento com o pré­
-aquecedor desligado. Vire o chip em QFN 
de terminais para cima, aplique um pouco 
de fluxo, estanhe a ponta-faca da estação 
de solda e enquanto isso aplique a solda 
derretida nos terminais do CI. SEM fazer 
força alguma! Tão pouca força que não

F8. Comparação de tamanho 
do CI em QFN.

¡9 x 94 x 4

2.0

Version E IS E S

Number of pins 16 1 16 64 64

A - Pitch (mm) 0.65 J 0.65 0.5 0.5

B - Lead pad length (mm) 0.92 1 0.92 0.69 0.69

C - Lead pad width (mm) 0.37 I037 0.28 0.28

D1 - Thermal pad width (mm) 2.0 1 2.0 7.1 7.1

7.1

0.75 0.5

D2 - Thermal pad length (mm)
Maximum component lead length (mm)

2.0

0.75

Maximum component lead width (mm) 0.37

precisa nem segurar o chip, o atrito dele 
com a manta antiestática é suficiente para 
espalhar a solda passando-a derretida sobre 
os terminais. Com a geometria e a tensão 
superficial criada pela ponta em faca, não é 
necessária uma dosagem de solda, pois há 
uma “divisão” da solda derretida entre os 
terminais do chip e a ponta desde que você 
não exceda na quantidade.

Como nem todo mundo tem uma ponta- 
-faca na estação de solda, faça a aplicação de 
solda derretendo-a de pouco em pouco só k

F7. Vista inferior de um CI em QFN 16. Observe 
que as medidas estão em mm.

I 037 103

T1. 
Medidas 
com seus 

valores 
em mm.

7.1

I 0.5

I 0.3

ense
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Eficiência V e Requerimentos de 90 W 
As Fontes de Alimentação do tipo desktop com en­
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ladas de 12 a 48 V cc em 
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com a quantidade suficiente para dois ou três 
terminais. Lembre-se que quanto mais solda 
você colocar, provavelmente mais solda você 
vai retirar. A quantidade de solda necessária 
é mínima. Este tempo de aquecimento des­
necessário pode danificar o seu CI!

Com o CI com seus terminais levemen­
te estanhados e a placa limpa, posicione o 
CI com a pinça. O CI não vai ficar plano 
em relação à placa devido à solda. Aplique 
o fluxo tanto no chip como na placa. Ligue 
o pré-aquecedor, aguarde alguns segundos 
(veja a curva de aquecimento do chip), com 
o soprador na mão de menor precisão, 
aqueça o conjunto. A fita kapton está no seu 
lugar? Assim que a solda derreter abaixo do 
chip ele vai se movimentar lentamente até 
a sua posição final.

Utilize a pinça na sua mão de maior 
precisão e dê super leves toques no chip 
para ter certeza que a solda está derretida e 
que o posicionamento está correto, obser­
ve numa lupa se for possível. Depois de ter 
esta certeza, afaste o soprador e desligue 
o pré-aquecedor SEM mexer na mesa. Se 
preferir pode aproximar novamente o so- 
prador com um ajuste de temperatura bem 
abaixo do que estava antes, isso é importan­
te para a estabilização da temperatura e o 
esfriamento da solda sem trincas, lembre-se 
que a solda “encolhe” um pouquinho, quase 
nada, na hora de se solidificar, mas isso pode 
ser mais que suficiente para que ela trinque 
e cause um mau contato que poderia ser 
facilmente evitado.

Não é fácil ensinar estas habilidades 
em textos escritos com fotografias e grá­
ficos. Sempre vale a pena reler os textos 
dos outros artigos da Revista que escrevi 
sobre o retrabalho, são mais de 12 páginas 
com um excelente conteúdo. Pensamos 
em uma apresentação em vídeo, mas ela 
nunca te dirá: “Você pode fazer tão bem 
quanto uma máquina. Apesar de sua ex­
periência como técnico, para este retra- 
balho a sua nota é 2.” Sem contar que há 
um sem número de vídeos assustadores 
que “ensinam” a por o dedo para segurar 
o chip, colar o chip com fita crepe, etc. 
Há outros ainda que ensinam como soldar 
de terminal em terminal, enquanto eu 
aprendi a soldar 10 a 14 terminais por 
segundo há mais de dez anos atrás!

Há muitas diferenças em aprender 
como hobby e aprender para ser profis­
sional, lembre-se de procurar as melhores

referências para seus estudos e práticas. 
Nesse sentido, a Editora Saber e eu, 
temos grandes preocupações quanto à 
profissionalização dos alunos, ao método, 
às técnicas e às avaliações. Este texto é 
um brevíssimo resumo do que ensinamos 
em nossos treinamentos na Editora e nas 
empresas. Em nossos treinamentos utili­
zamos até uma palmatória como recurso 
pedagógico! E funciona.

Desejo que tenha sido o suficiente 
para atender algumas de suas dificuldades 
e que com estas informações você consiga 
caminhar de modo independente no seu 
retrabalho do dia a dia. E

QFN BODY
PCB I/O LAND 

WIDTH SAME AS

SAME AS 0.2mm
PCB THERMAL LAND

DIMENSIONS

QFN I/O PAD WIDTH

( I QFN PADS

( IPCB LANDS

F10. A diferença dimensional entre os PADs 
_____ da placa e os terminais do CI em QFN.

F11. Curva específica de soldagem e ressolda- 
gem de um QFN 16, segundo seu fabricante.

Escala (soprador) °C em 10 mm °C em 20 mm °C em 30 mm °C em 40 mm
1

1,5

2

2,5 T2. Mapea- 
mento de 

temperatura.
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Desenvolvimento
à fr

Aplicando o MOSFET de __ 
forma a reduzir indutâncias 
e capacitâncias parasitas em 
dispositivos eletrônicos

Este artigo desenvolve a análise do 
MOSFET abordando suas principais 
características em diversas situa­

ções, propondo modelamentos de 
seu comportamento em Circuitos de 
primeira e segunda ordem (Circuitos 
RL, RC e RLC) e soluções por meio de 
equações diferenciais.

Além disso, ele desvenda as princi­

pais causas e natureza do problema 
abordado, possibilitando a preven­

ção e meios de evitá-lo.

Tiago Almeida de Oliveira 
Mário Marcos de Brito Horta

Arlete Vieira da Silva

H
oje em dia, em uma única pastilha 
de silício - Si pode-se inserir mi­
lhões de circuitos, melhorando a 
mobilidade e processamento das 
Inovações Tecnológicas existentes. Estas 

pastilhas são comumente chamadas de 
Circuitos Integrados - CI. Analisando-se 
os dispositivos eletrônicos atuais, é difí­
cil encontrar algum que não faça uso de 
algum CI. Como por exemplo, o micro­
processador utilizado em Computadores, 
Notebooks, Ultrabooks e Smartphones é 
indispensável a estes equipamentos.

O MOSFET - transistor de efeito de 
campo de metal-óxido-semicondutor - é 
atualmente um dos dispositivos mais 
importantes no desenvolvimento de 
circuitos integrados, pois cada CI pode 
possuir milhões de transistores. Segun­
do Boylestad e Nashelsky (1996), seu 
tamanho e estabilidade térmica, entre 
outras características, o tornam ideal para 
confecção em larga escala, sendo muito 
utilizado em projetos de computadores 
e outros aparatos eletrônicos. Contudo, 
seu manuseio requer conhecimentos de 
suas características em chaveamentos de 
alta frequência, diversas polarizações e 
no comportamento ante os vários níveis 
de campo elétrico. Assim, seu uso sem as 
devidas precauções e conhecimento de 
seu comportamento em situações diversas 
pode ocasionar fenômenos parasitas que 
prejudicam seriamente o processamento 
de seu circuito lógico. E entre estes fenô­
menos estão a Indutância e Capacitância 
Parasitas, que ocasionam atrasos de 
propagação (delays) e repiques (também 
conhecido como debounce).

Os delays são o que motivam a troca de 
computadores e notebooks todos os anos. 
Já os repiques, que causam comutações 
indesejadas no período de processamento, 
são incômodos em chaveamentos que re­
querem precisão. Assim, exemplificando: 
em um placar eletrônico onde uma comuta­
ção implica, por exemplo, numa mudança 
de 0 para 1, seria muito indesejada uma 
mudança de 0 a 6 (ou 0 a 5). Outros efeitos 
indesejáveis devido aos repiques também 
devem ser minimizados em chaveamen- 
tos que requerem precisão, tais como em 
equipamentos médicos e fisioterapêuticos.

Então, diante da demanda de solu­
ções para fenômenos envolvendo o uso 
de MOSFET e aumento de frequência de 
processamento cada vez maior em circui­
tos lógicos digitais, buscou-se minimizar 
e entender a Indutância e Capacitância 
Parasitas em chaveamentos com MOSFET, 
propondo uma solução viável ao pro­
blema a partir da análise dos resultados 
obtidos e discutindo sua viabilidade.

Referencial Teórico
Segundo Boylestad e Nashelsky 

(1996), o surgimento do MOSFET culmi­
nou em um grande avanço tecnológico 
por ser fácil sua fabricação, ter alto desem­
penho e proporcionar integração em larga 
escala, isto é, seu tamanho é cerca de vinte 
vezes menor que o Transistor de Junção 
Bipolar - TJB, permitindo que um grande 
número de transistores seja produzido em 
um mesmo circuito integrado.

Os mesmos autores afirmam que o 
MOSFET - Metal Oxide Semiconductor 
Field-Effect-Transistor (Transistor de Efeito
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de Campo Metal-Óxido-Semicondutor) 
- pertence a uma classe de dispositivos 
semicondutores chamada de Transistores. 
Ele possui três terminais: um terminal de 
controle chamado Gate (ou Porta), um 
terminal de entrada chamado de Drain 
(ou Dreno) e outro terminal de saída cha­
mado Source (ou Fonte). E subdivide-se 
em Tipo Depleção e Tipo Intensificação, 
tendo cada um destes modos de operação 
diferentes. E possuem na sua construção o 
contato metálico do terminal de porta, que 
é separado do substrato por uma camada 
isolante de dióxido de Silício SIO2.

Os mesmos autores ressaltam que 
o MOSFET pode ser dividido em dois 
tipos: MOSFET tipo Depleção e MOS­
FET tipo Intensificação. O segundo tem 
várias aplicações na Eletrônica onde se 
exige chaveamento em altas frequências 
e construção de portas lógicas. Como, por 
exemplo, microprocessadores utilizados 
em Notebooks com frequência de 2 GHz 
(dois bilhões de chaveamento por segun­
do) utilizam MOSFETs. A figura 1 mostra 
múltiplas portas OR e NAND.

Capacitância
De acordo com O’Malley (1994), Ca- 

pacitância é a medida da capacidade de 
armazenar cargas nos condutores quando 
separados por algum dielétrico.

Especificamente, se a diferença de 
potencial entre os dois condutores é de 
volts (V) quando existe uma carga positiva 
de Q coulombs em um condutor e uma 
carga igual negativa no outro, o capaci­
tor possui uma capacitância descrita na 
equação a seguir.

F1. Múltiplas portas 
A) OR e B) NAND.

F2. Passos para análise de Circuitos 
de Primeira ordem.

Onde C é o símbolo de capacitância.

A unidade SI de capacitância é o fa­
rad (F), unidade esta muito grande para 
aplicações práticas, sendo o microfarad 
(^F) e o picofarad (pF) mais comumente 
utilizados.

O’Malley (1994) ainda ressaltou que 
para um capacitor de placas paralelas, a 
capacitância em farad é representada pela 
equação a seguir.

Onde A é a área de cada uma das placas 
em m2, d é a distância (em metros) entre as 
placas, e Ç é a permissividade do dielétrico 
em farads por metro (F/m).

Aumentando a área das placas ou 
reduzindo a distância entre elas ou au­
mentando a permissividade do dielétrico, 
tem-se um aumento na capacitância. Já a 

permissividade £ é relativa ao comporta­
mento atômico do dielétrico.

A energia armazenada em um ca­
pacitor, que pode ser comprovada por 
cálculos, é dada pela seguinte equação:

Wc =-CV2 
6 2

Onde: Wc é em joules, C em farads e Vem 
volts.
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Desenvolvimento

Assim, percebe-se que a energia ar­
mazenada não depende da corrente no 
capacitor.

Indutância
Segundo Dorf e Svoboda (2008), a 

Indutância uma característica intrínseca 
que cada indutor possui de capacidade de 
armazenamento de energia em forma de 
campo magnético. A unidade de medida 
de indutância em SI é o henry. E pode ser 
definida pela equação:

T N2^A 
l

Onde N é o número de espiras de um con­
dutor, A é área de seção reta do núcleo em 
m2, l é o comprimento da bobina em me­
tros e p é a permeabilidade relativa mag­
nética do meio.

Assim, através desta fórmula, pode­
mos perceber a característica puramente 
construtiva da indutância.

A energia armazenada em um indutor 
é dada pela equação a seguir.

V, =-Li2
L 2

Onde WL em joules, L em henrys e I em 
ampères.

Esta energia, que pode ser demons­
trada através de cálculos, é a energia 
armazenada no campo magnético ao 
redor do indutor. Também, pela fórmula 
5, percebe-se que energia armazenada 
no indutor depende de sua corrente e da 
indutância do dispositivo e como esta 
não varia por se tratar de um aspecto 
puramente construtivo, somente pode se 
interferir nesta energia pela sua corrente.

Circuitos RL e RC
Segundo Dorf e Svoboda (2008), os cir­

cuitos RC e RL de primeira ordem contêm 
apenas um elemento de energia e são re­
presentados por equações diferenciais de 
primeira ordem. Ou seja, se o circuito tiver 
apenas um indutor e nenhum capacitor 
(ou apenas um capacitor e nenhum in­
dutor) podem ser representados por uma 
equação diferencial de primeira ordem.

Assim, se há qualquer circuito elétrico 
de primeira ordem contendo capacitor ou 
indutor, pode-se analisá-lo pelos teoremas 
de Norton e Thevenin. A figura 2 ilustra 
estes passos: primeiramente, isola-se o 
elemento de armazenamento de energia 
(capacitor ou indutor) e, em seguida, 
substitui-se o circuito ligado ao capacitor 
pelo equivalente de Thevenin e o circuito 
ligado ao indutor pelo equivalente de 
Norton. Então, se obtém sua resposta 
natural e ao degrau.

Segundo Nilsson e Riedel (2009), 
é considerada resposta natural de um 
circuito de primeira ordem quando as 
correntes e tensões do circuito se descar­
regam em uma rede resistiva por meio 
da energia armazenada no capacitor ou 
indutor. Ou seja, o elemento de armaze­
namento de energia descarrega a energia 
potencial armazenada.

Para a resposta natural de um circuito 
RL, tem-se a seguinte equação de corrente:

E para um circuito RC, tem-se a se­
guinte equação de tensão:

v{t)=Voe-"(RC}

Onde Io e Vo são os valores iniciais 
(em t=0+) de corrente e tensão no Indutor 
e Capacitor, respectivamente.

Segundo Nilsson e Riedel (2009), 
denomina-se resposta ao Degrau de um 
Circuito de Primeira Ordem quando o 
mesmo é submetido a uma aplicação 
repentina de uma fonte de tensão ou 
corrente constante.

Deste modo, tem-se para esta resposta 
uma equação para corrente em circuito RL 
e uma equação de tensão para circuitos 
RC:

v(t)=lsR+\Vo-lsR<e~"{RC',t>0

Circuitos RLC
O circuito RLC também é conhecido 

como um circuito de segunda ordem, pois 
possui dois elementos de armazenamento 
de energia - o capacitor e o indutor. Além 
disso, ele pode ser representado por uma 
equação diferencial de segunda ordem.

Segundo Dorf e Svoboda (2008), a 
ordem da equação diferencial que repre­
senta um circuito é no máximo igual à 
soma do número de capacitores com o 
número de indutores. Assim, um circuito 
de segunda ordem pode conter, por exem­
plo, um capacitor e um indutor ou dois 
capacitores e nenhum indutor.

Este tipo de circuito pode ser repre­
sentado pela equação mostrada abaixo:

d2x(t) 

dt2
+ 2a dx(r) 

dt
+w2x(t} = f(t}

Onde x(t) é a saída do circuito e f(t) é a en­
trada do circuito.

A saída do circuito, também chamada 
de resposta do circuito, pode ser a corren­
te ou a tensão de qualquer componente do 
circuito. A saída é frequentemente escolhi­
da como sendo a corrente em um indutor, 
ou a tensão em um capacitor. As entradas 
do circuito podem ser tensões de fontes 
de tensão independentes e/ou correntes 
de fontes de corrente independentes. 
Os coeficientes da equação diferencial 
recebem nomes especiais: a é chamado 
de amortecimento e wo de frequência de 
ressonância.

De acordo com Dorf e Svoboda (2008), 
para representar a resposta de um circuito 
de segunda ordem deve-se:

• Representar o circuito por uma 
equação diferencial de segunda 
ordem.

• Obter a solução geral da equação 
diferencial homogênea. Esta solu­
ção é a resposta natural, xo (t).

• Obter uma solução particular da 
equação diferencial. Esta solução 
é a resposta forçada, x1 (t).

• Usar as condições iniciais, como 
por exemplo, os valores iniciais das 
correntes nos indutores e das ten­
sões nos capacitores, para calcular 
as constantes da resposta natural.
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F3. Circuito RLC F4. Circuito RLC em série usado para ilustrar a res-
em série. posta a um degrau de um circuito desses.

F5. Resposta natural e ao degrau 
de um Circuito RLC.

Assim, dados os circuitos RLC em série 
da figura 3, utilizados para ilustrar o com­
portamento da resposta natural de um cir­
cuito RLC, chega-se as seguintes equações:

5, 2 = — a ± v a~ —

De acordo com Nilsson e Riedel (2009), 
a resposta do circuito será superamor- 
tecida, subamortecida ou criticamente 
amortecida conforme a>20 < a, w20> a, ou 
w20 = a, respectivamente. Assim, as três 
soluções possíveis para a corrente são as 
seguintes equações:

i(t)=A]e’,l+A2e’1' 

i(t)=Ble coscollt+ B2e al sen codt 

i(t)=D]te"'+D2e~a'

Assim, como foi achada a resposta de 
corrente do circuito RLC em série, tam­
bém é possível se encontrar a resposta da 
tensão. Para isso, suponha o seguinte cir­
cuito que é usado para ilustrar a resposta 
a um degrau (figura 4).

Desta forma, para o circuito da figura 4 
pode se encontrar sua resposta ao degrau, 
por meio desta equação:

d2 vc R dvc vc _ V 
dr + L dt+ LC~ LC

Assim, trabalhando-se na próxima 
equação da mesma forma que traba­
lhamos anteriormente, resultando nas 
seguintes sentenças que representam 
as formas de respostas a um degrau da 
tensão no capacitor em circuitos RLC 
em série:

v=V )+A\e', + À2e'-'

vc-V l+Ble~"1^tüílt + B2e~a> sen <odt 

v=V , + D\te~a,+ D 2e~M

A figura 5 revela as formas de ondas 
possíveis para tensão e corrente para res­
postas subamortecidas (Under damped), 
superamortecidas (Over damped) e criti­
camente amortecidas (Critically damped).

Capacitância e Indutância 
Parasitas em MOSFET

Em estudos de circuitos eletrônicos, 
muitas das vezes, costuma-se ignorar o 
tempo entre chaveamentos. Porém, na 
prática, comutações nestes circuitos estão 
longe de serem estáticas, ou seja, não ocor­
rem instantaneamente e tampouco suas 
saídas dependem apenas de suas entradas.

Assim, para ilustrar esta assertiva, 
suponha que o circuito da figura 6 repre­
senta dois inversores em cascata. Se des­
prezarmos o tempo entre chaveamentos, 
considerando uma disciplina estática dos 
dispositivos e de seu comportamento, tem­
-se uma resposta ideal como demonstrado 
na figura 7. Contudo, o que de fato ocorre 
é que, na prática, se observa uma saída 
semelhante à da figura 8.

Para explicar este comportamento 
não ideal de circuitos lógicos digitais, a 
compreensão da indutância e capacitância 
é fundamental. Por exemplo, de acordo 
com Agarwal e Lang (2005), a capacitância k 
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interna do MOSFET é diretamente res­
ponsável pela resposta não ideal vista na 
figura 8. Portanto, pode-se representar um 
modelo mais verossímil de dois inversores 
em cascata conforme exibe a figura 9.

Sadiku (2003) relatou que, de acordo 
com a Lei Circuital de Ampére, todo con­
dutor de comprimento l ao ser percorrido 
por uma corrente i gera ao redor de si 
um campo magnético B. Assim, pode-se 
observar na figura 9 a representação deste 
campo magnético devido à interconexão 
entre circuitos. Muitas das vezes este efeito 
é desprezado. Contudo, hoje em dia, em 
que se busca mais e mais mobilidade no 
que diz respeito à tecnologia de eletrôni- 
cos, tem-se uma tendência muito grande 
em se ter mais e mais circuitos por metro 
quadrado, não sendo, portanto, este efeito 
totalmente desprezível.

Agarwal e Lang (2005) também afir­
mam que as interconexões entre circuitos 
lógicos geram diferenças de potenciais 
armazenando uma carga q, gerando um 
campo elétrico E entre os terminais positi­
vos e negativos. Além disso, segundo eles, 
a resistência entre estas conexões não é ne­
cessariamente zero. Assim, chegou-se a um 
modelo de circuito eletrônico semelhante 
ao da figura 10, onde se tem considerado a 
resistência parasita devida a interconexões, 
a indutância parasita devida ao campo 
magnético criado pela corrente elétrica 
que percorre o caminho fechado entre os 
terminais, e a capacitância parasita devida 
a características internas do MOSFET e ao 
campo elétrico criado pela diferença de 
potencial nas conexões culminando-se, en­
tão, em um modelo real de conexões entre 
dispositivos e circuitos eletrônicos lógicos.

Metodologia
Segundo GIL (2002), a pesquisa é defi­

nida como o procedimento racional e siste­
mático que tem por objetivo proporcionar 
respostas aos problemas que são propos­
tos. A pesquisa é requisitada quando não 
se dispõe de informação suficiente para 
responder ao problema, ou então quando 
a informação disponível se encontra em 
tal estado de desordem que não possa ser 
adequadamente relacionada ao problema.

O autor afirma ainda que a pesquisa 
seja desenvolvida mediante os conhe­
cimentos disponíveis e a utilização cui­
dadosa de métodos, técnicas e outros

F10. Modelo real de dois inversores em cascata, considerando-se 
______________ os efeitos da indutância e capacitância parasitas.

procedimentos científicos. Na realidade, 
a pesquisa desenvolve-se ao longo de 
um processo que envolve inúmeras 
fases, desde a adequada formulação do 
problema até a satisfatória apresentação 
dos resultados.

O mesmo autor relata que toda e qual­
quer pesquisa se faz mediante critérios, os 
quais são classificados em pesquisa docu­
mental e experimental, e este trabalho de 
acordo com seu objetivo geral, classifica-se 
como uma pesquisa documental e experi­
mental. A parte documental consiste no 
fato da mesma ser desenvolvida com base 
em material já elaborado, constituído prin­
cipalmente de livros e artigos científicos 
e, a experimental por definir um objeto a 
ser estudado, além de envolver coleta de 
dados técnicos para o desenvolvimento e 

comprovação teórica e prática no funcio­
namento do sistema proposto.

Assim, elaborou-se uma pesquisa 
com materiais bibliográficos existentes, 
dissertações de mestrado, monografias e 
testes práticos em laboratórios de Circuitos 
Eletrônicos Digitais.

Para minimizar a Indutância e Capa- 
citância Parasitas em chaveamentos com 
MOSFET chegou-se a um modelamento 
matemático do problema por meio de 
Equações Diferenciais e um modelamento 
de Circuitos como Sistemas de Segunda 
Ordem, culminando-se em uma solução 
geral do problema e, então, apurou-se os 
resultados obtidos por meio de experi­
mento prático.

Acompanhar na Parte 2 deste artigo, 
na próxima edição. E
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Desenvolvimento

Visual Studio, Windows 8 e a 
Linguagem C# na eletrônica

Nos dias de hoje, os tablets, os 
dispositivos eletrônicos industriais, 
os celulares, etc., estão começando 
a usar sistemas operacionais para 
gerenciar a execução de programas. 
Este artigo mostra como usar o 
Visual Studio e a Linguagem C para 
criar programas que se executam 
nos tablets e em computador com 
Windows 8.

Alfonso Pérez 
alfaelectronica@hotmail.com 

Tradução: Eutíquio Lopez

S
aber programar em qualquer lin­
guagem é uma necessidade nos 
dias de hoje. Mesmo para quem 
não é programador, aprender a 
programar computadores desenvolve a 

mente e a maneira como pensar sobre 
essas coisas. Para desenvolver os pro­
gramas deste artigo usaremos o Visual 
Studio 2012 Express para Windows 8, 
que pode ser baixado gratuitamente no 
site www.visualstudio.com. Antes de 
começar a instalação de Visual Studio, é 
necessário instalar o sistema operacional 
Windows 8.

A linguagem C#
A linguagem C é uma melhoria da 

linguagem C/C++, o que a torna mais mo­
derna e, tecnologicamente, mais avançada. 
A linguagem C# é orientada a objetos. Para 
usar objetos é necessário criar algum tipo 
de dado. Estes tipos de dados são chama­
dos de “Classes”. No seguinte exemplo, 
criaremos uma classe chamada “Timer”:

public class Timer
{

public Timer()
{
IsEnable = false;
}
public TimeSpan Interval { get; set; } 
public bool IsEnabled { get; set; } 
public void Start()
{

IsEnable = true;
}
public void Stop()
{

IsEnable = false;
}

}

Essa classe tem 2 propriedades/variá- 
veis, chamadas de “IsEnable” e “Interval”. 
Tem também 3 métodos/funções, chama­

dos de “Start()”, “Stop()”, e “Timer()”. A 
propriedade “InEnable” é do tipo “bool”, 
e a propriedade “Interval” é do tipo “Ti­
merSpan”. Os métodos são “públicos” 
(public), ou seja, podem ser chamados 
por outras classes e o tipo de retorno dos 
métodos é nulo.

Para criar um objeto da classe “Timer” 
é necessário usar uma linha de código 
como a seguinte:

Timer _timer = new Timer();

Para uma melhor organização das 
classes criadas em um projeto qualquer, 
costuma-se usar a seguinte linha de 
código:

namespace Robot
{
}

“Robot” seria o nome do projeto. Caso 
outro projeto queira usar as classes criadas 
no “namespace Robot”, poderá empregar 
uma linha de código conforme:

using Robot;

Os exemplos a seguir mostram como 
usar a linguagem C# para programar.

Contador
Este programa mostra como usar os 

contadores. Para iniciar, abra o Visual 
Studio e clique no menu: “File > New 
Project”. Aparecerá uma janela conforme 
visto na figura 1.

Na lista de linguagens do lado esquer­
do da figura (JavaScript, Visual Basic, 
Visual C#, Visual C++), escolha “Visual
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C#”e a opção: “Windows Store”. Na janela 
ao lado, selecione: “Blank App (XAML)”.

Dê um nome ao seu projeto na caixa 
de edição “Name:”, como por exemplo: 
“Contador”. Na caixa de edição “Loca­
tion:”, selecione a pasta para guardar o 
projeto. Aperte o botão “OK” e o Visual 
Studio irá gerar os arquivos necessários 
para o projeto. A figura X mostra os ar­
quivos gerados.

Escolha o arquivo “MainPage.xaml” 
(figura 2) e, automaticamente, abre-se o 
editor gráfico. Selecione o menu “VIEW 
> TollBox” e surgirá uma janela como a 
mostrada na figura 3. Esta janela exibe 
os controles que podem ser usados no 
programa (controles também são consi­
derados “classes”).

Crie 3 botões (Button) e um bloco de 
texto (TestBlock). Agora é necessário das 
nomes a esses controles. Para fazê-lo, 
escolha o menu: “VIEW > Properties Win­
dow”. Aparecerá uma janela de acordo 
com a figura 4.

Edite os nomes para os controles na 
caixa de edição “Name”: Para os botões 
foram usado os nomes: “IncrementarBut- 
ton”, “DecrementarButton” e “ZeroBut­
ton”. Foi usado o nome “CountTextBlock” 
para o bloco de texto. Lembramos que 
foram empregados estes nomes, mas 
nada impede de utilizar outros para os 
controles.

Agora, é preciso criar um método 
ou função (Rotina) para cada um dos 3 
botões. Para fazê-lo, dê um clique duplo 
em cada um deles (no editor gráfico). Será 
criado um código conforme segue:

prívate void IncrementarButton_Click(object 
sender, RoutedEventArgs e)

{
}

private void DecrementarButton_ 
Click(object sender, RoutedEventArgs e)

{
}

private void ZeroButton_Click(object 
sender, RoutedEventArgs e)

{
}

Crie uma variável de tipo “int” (Inteiro) 
chamada “_count” para armazenar o valor 
do contador. No método “MainPage()”

F1. Novo 
Projeto.

Quick Launch a

Solution Explorer

a ’o ■
Search Solution Explorer (Ctrl* 5)

51 Solution 'Contador' (1 project) 

a Contador
t> A Properties
> ■ ■ References

£ I
3

a Common
P) App xami
S3 C ontadorï emporaryKey .pfx

8

> D MamPagexaml
|b] Package.appxmanifest

F2. Arquivo Main­
______ Page.xaml.

inicialize a variável “_count” com zero (0) 
e mostre-a no bloco de texto: “CountBlo­
ckText”. Esta classe (controle) tem uma 
propriedade chamada “Text”, na qual fica 
armazenado o dado que será apresentado 
na tela (display). Tendo em vista que esta 
propriedade é do tipo “string”. Para fazê­
-lo, use o método “ToString”.

«0 Contador - Microsoft Visual Studio ExpresJ 

FILE EDIT VIEW PROJECT BUILD DEBUG '

10 tì u b? ► Local M

Toolbox •* -o X

fi * 

o P Callisto 
? P Advertising 

a Common XAML Controls

Pointer
3 H Border I

H Q Button

£. [3 CheckBox

3 ComboBox

•n- FlipView

::: Grid

Jj: GndView

FT Image

[3 List View

O RadioButton

□ Rectangle

[Bl StackPanel

FT1 TextBlock 

@ t extBox 

P All XAML Controls 
a General

There are no usable controls in this group. Drag an 
item onto this text to add it to the toolbox.

Output Error List F3. Menu 
“Toolbox”

Crie, agora, o código para incremen­
tar, decrementar e zerar a variável. Para 
fazer isso, usam-se as instruções:

Incrementar (++)
Decrementar (--)
Fixar um valor (=)
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F4. Propriedades 
_____ do projeto.

O código para o arquivo “MainPage. 
xaml.cs” é o seguinte:

public sealed partial class MainPage : Page
{

int _count;
public MainPage()
{

this.InitializeComponent();
_count = 0;

}
protected override void OnNavigatedTo(Na 

vigationEventArgs e)
{
}
private void IncrementarButton_

Click(object sender, RoutedEventArgs e)
{

_count++;
CountTextBlock.Text = _count.ToString();

}
private void DecrementarButton_

Click(object sender, RoutedEventArgs e)
{

_count--;
CountTextBlock.Text = _count.ToString();

}
private void ZeroButton_Click(object 

sender, RoutedEventArgs e)
{

_count = 0;
CountTextBlock.Text = _count.ToString();

}
}

Compile o programa. Escolha o menu 
“DEBUG > Start Debugging” e teste o fun­
cionamento dos botões. Seria executado 
um programa semelhante ao da figura 5.

Temporizador
Este programa demostra a forma de 

usar os temporizadores. Para iniciar, 
abra o Visual Studio e clique no menu: 
“File > New project”. Surgirá uma janela, 
conforme exibe a figura 1.

Na lista de linguagens no lado esquer­
do dessa figura, selecione Visual C# e es­
colha a opção “Windows Store”. Selecione 
“Blank App (XAML)” na janela ao lado.

Na caixa de edição “Name:”, nomeie 
seu projeto como, por exemplo, “Tempo­
rizador”. Na caixa “Location:”, selecione 
a pasta para guardar o projeto. Aperte o 
botão “OK” e o Visual Studio irá gerar os 
aquivos necessários ao projeto.

Selecione o arquivo “MainPage.xaml” 
(figura 2) e, automaticamente, se abre o 
editor gráfico. Escolha o menu “VIEW > 
ToolBox” e aparecerá uma janela confor­
me a figura 3.

Crie 2 botões (Button) e um bloco de 
texto (TextBlock). É preciso, agora, dar 
nome a esses controles. Para fazer isso, 
selecione o menu: “VIEW > Properties

Window”. Surgirá uma janela igual à 
da figura 4.

Edite os nomes para os controles na 
caixa de edição “Name:”. Para os botões, 
foram usado os nomes “StopButton” 
e “StartButton”. Para o bloco de texto, 
utilizou-se o nome “CountTextBlock”.

Agora, é necessário criar um método 
ou função (Rotina) para cada botão. Para 
fazê-lo, clique em cada um dos 2 botões 
no editor gráfico. Será criado um código 
como o seguinte:

private void StartTimer_Click(object sen­
der, RoutedEventArgs e)

{
}
private void StopButton_Click(object 

sender, RoutedEventArgs e)
{ 
}

Crie um objeto ou variável do tipo 
“Dispatcher Timer” chamada de “_timer”, 
e uma variável do tipo “int” (Inteiro) 
chamada de “_count”. Inicialize a pro­
priedade “_timer.interval” no método 
“MainPage()” com um valor em milisse- 
gundos. Para fazer isso, use uma linha de 
código como a seguinte:
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_timer.Interval = TimeSpan. 
FromMilliseconds(1000);

Agora, é preciso escolher um método 
que seria executado quando o tempori­
zador completasse o tempo programado. 
Para fazer isso, pode ser usada uma linha 
de código como a seguinte:

_timer.Tick += new
EventHandler<object>(timer_tick);

Onde, “timer_tick” é o método que 
controla o evento temporizador. Para 
demonstrar o seu funcionamento, cada 
vez que o tempo programado termina, a 
variável “_count” é incrementada. Esta 
variável é ilustrada no bloco de texto 
“CountBlockText”.

Esta classe (controle) tem uma pro­
priedade chamada “Text”, na qual é ar­
mazenado o dado que seria apresentado 
na tela (display). Como esta propriedade 
é do tipo “string”, é necessário que a va­
riável “_count” passe para “string”. Para 
fazer isso usa-se o método “ToString()”.

O evento que controla o botão “Star­
tButton” inicializa o temporizador, e o 
que controla o “StopButton” para (stop) 
o temporizador.

O código para o arquivo “MainPage. 
xaml.cs” é o seguinte:

public sealed partial class MainPage : Page
{

DispatcherTimer _timer = new 
DispatcherTimer();

int _count = 0;

public MainPage()
{

this.InitializeComponent();
_timer.Interval = TimeSpan.

FromMilliseconds(1000);
_timer.Tick += new 

EventHandler<object>(timer_tick);
CountTextBlock.Text = _count.ToString();

}
public void timer_tick(object sender, object 

args)
{

_count++;
CountTextBlock.Text = _count.ToString();

}
protected override void OnNavigatedTo(Na 

vigationEventArgs e)
{

F5. Contador 
do projeto.

F6. Temporizador 
do projeto.

}
private void StartTimer_Click(object 

sender, RoutedEventArgs e)
{

_timer.Start();
}
private void StopButton_Click(object 

sender, RoutedEventArgs e)
{

_timer.Stop();
_count = 0;
CountTextBlock.Text = _count.ToString();

}
}

Compile o programa. Selecione o 
menu “DEBUG > Star Debugging” e 
teste o funcionamento dos botões. Um 
programa igual ao da figura 6 seria 
executado.

Relógio
Este programa demonstra como usar 

o relógio do sistema. Para iniciar, abra o 
Visual Studio e clique no menu “File > 
New project”. Surgirá uma janela idêntica 
à da figura 1.

Na lista de linguagens que aparece do 
lado esquerdo, escolha Visual C# e clique 
em “Windows Store”. Selecione na janela 
ao lado “Blank All (XAML)”.

Na caixa de edição “Name:” nomeie o 
seu projeto como, por exemplo, “Reloj” e 
na caixa “Location:” selecione a pasta para 
guardar o projeto. Aperte o botão “OK” 

e o Visual Studio irá gerar os arquivos 
necessários ao projeto.

Escolha o arquivo “MainPage.xaml” 
(figura 2) e o editor gráfico abre-se auto­
maticamente. Selecione o menu “VIEW > 
ToolBox” e surgirá uma janela conforme 
mostrado na figura 3. Crie um bloco de 
texto: (TextBlock).

Agora, é preciso dar nome a esses 
controles. Para fazer isso, escolha o menu 
“VIEW > Properties Window”. Aparecerá 
uma janela igual à da figura 4. Edite os 
nomes para o controle na caixa “Name:”. 
Para o bloco de texto foi usado o nome 
“RelojTextBlock”.

Este programa utiliza o mesmo proce­
dimento que o programa temporizador, 
ou seja, é criado um temporizador para 
atualizar os dados na tela. No método 
“timer_tick(object sender, object args)” é 
utlizada a seguinte linha de código para 
acessar o relógio:

RelojTextBlock.Text = DateTime.Now. 
ToString(“HH:mm:ss”);

“DateTime” é uma estrutura que 
tem acesso ao relógio e formata dados 
conforme a necessidade. Neste caso, foi 
usado: “HH:mm:ss” representando hora, 
minuto, segundo.

O código para o arquivo “MainPage. 
xaml.cs” é o seguinte:
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public sealed partial class MainPage : Page
{

DispatcherTimer _timer = new 
DispatcherTimer();

public MainPage()
{

this.InitializeComponent();

_timer.Interval = TimeSpan.
FromMilliseconds(100);

_timer.Tick += new 
EventHandler<object>(timer_tick);

_timer.Start();
}

public void timer_tick(object sender, object 
args)

{
RelojTextBlock.Text = DateTime.Now. 

ToString(“HH:mm:ss”);
}

protected override void OnNavigatedTo(Na 
vigationEventArgs e)

{
}

}

Compile o programa. Selecione “DE­
BUG > Start Debugging” e teste o funcio­
namento dos botões. Um programa como 
o da figura 7 seria executado.

Cronômetro
Este programa demonstra a maneira 

de usar o relógio do sistema para fazer 
um cronômetro. Para iniciar, abra o 
Visual Studio e clique no menu “File > 
New project”. Surgirá uma janela igual 
à da figura 1.

Na lista de linguagens do lado es­
querdo desta figura, escolha Visual C# e 
a opção “Windows Store”. Selecione na 
janela ao lado “Blank App (XAML)”.

Na caixa de edição “Name:” dê um 
nome para seu projeto, como por exemplo 
“Cronômetro”, e na caixa “Location:” 
escolha a pasta para guardar o projeto. 
Aperte o botão “OK” e o Visual Studio irá 
gerar os arquivos necessários ao projeto.

Selecione o arquivo “MainPage.xaml” 
(figura 2) e o editor gráfico abre automa­
ticamente. Escolha o menu “View > To­
olBox” e aparecerá uma janela conforme 
mostra a figura 3. Crie um bloco de texto 
(TextBlock).

É necessário, agora, nomear esse 
controle. Para fazer isso, selecione o 
menu “View > Properties Window”.

Appi - Microsoft Visual Studio Express 2012 for Windows 8 
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM DESIGN FORMAT

O ’ Ì0 £ W d- ' ’ ► Local Machine - Debug - Any CPU

c MainPage-xaml -a X App.xaml.cs ► Local Machine ________

Simulator

□ Local Machine I
Remote Machine _

F9. Local 
Machine.

Appi - Microsoft Visual Studio Express 2012 for Windows 8

FILE EDIT VIEW PROJECT BUILD DEBUG TEAM DESIGN FORMA

O ’ Ì0 S3 U Simulator * Debug - AnyCPL

' MainPage-xaml * X Appxaml.es ► Simulator

Simulator
X

o -4 Local Machine
? i-■ Remote Machine ... .F10. Ativando o 

simulador.

Contador

Surgirá uma janela como a da figura 
4. Edite os nomes para o controle na 
caixa de edição “Name:”. Para o bloco 
de texto foi usado o nome “Cronome- 
troTextBlock”.

Este programa usa o mesmo proce­
dimento do programa Temporizador, 
ou seja, é criado um temporizador para 
atualizar os dados na tela. No método 
responsável pelo evento do tempo­
rizador: “timer_tick(object sender, 
object args)” é usada a seguinte linha 
de código:

F11. Tablet 
simulado.

TimeSpan timeSpan = DateTime.Now - 
_dateTime;
CronometroTextBlock.Text = timeSpan.
ToString(“mm\\:ss\\.fff”);

“TimerSpan” é uma estrutura que re­
presenta um intervalo de tempo. O méto­
do de controle do botão: “StartButton” en­
carrega-se de armazenar o tempo quando 
este evento acontece, e formata os dados 
conforme a necessidade. Neste caso, foi 
usado “mm\\:ss\\.fff”, representando: 
minuto, segundo e milissegundo.
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O código para o arquivo “MainPage. 
xaml.cs” é o seguinte:

public sealed partial class MainPage : Page
{

DispatcherTimer _timer = new 
DispatcherTimer();

DateTime _dateTime;
public MainPage()
{

this.InitializeComponent();
_timer.Interval = TimeSpan.

FromMilliseconds(50);
_timer.Tick += new 

EventHandler<object>(timer_tick);
}

public void timer_tick(object sender, object args)
{

TimeSpan timeSpan = DateTime.Now
- _dateTime;

CronometroTextBlock.Text = timeSpan. 
ToString(“mm\\:ss\\.fff”);

}
protected override void OnNavigatedTo(Na 

vigationEventArgs e)
{
}
private void StartButton_Click(object 

sender, RoutedEventArgs e)
{

_dateTime = DateTime.Now;
_timer.Start();

}
private void StopButton_Click(object 

sender, RoutedEventArgs e)
{

_timer.Stop();
}

}

Compile o programa. Selecione o menu 
“DEBUG > Start Debugging” e teste o fun­
cionamento dos botões. Seria executado 
um programa como o da figura 8.

Estes programas são exemplos que 
podem ser usados em casos específicos, 
ou conforme a necessidade. Experimente 
utilizar uma ferramenta do Visual Studio 
para simular um Tablet. Para fazer isso, 
encontre um botão igual ao da figura 9 e 
escolha “Simulador” (figura 10).

Compile, agora, o programa. Selecione 
o menu “DEBUG > Start Debugging” e tes­
te a execução do programa em um Tablet 
simulado (figura 11). O código-fonte para 
estes programas-exemplos pode ser baixa­
do no site www.sabereletronica.com.br.

Para maiores informações, acesse as 
seguintes páginas: www.microsoft.com; 
www.dev.widows.com; www.visuals- 
tudio.com E

Projetos de
Circuitos á-%Digitais 

com FPGA

Projetos de 
Circuitos
Digitais 
com FPCR
Mostra o emprego de novas fer­
ramentas computacionais no 
desenvolvimento de projetos por 
meio de exemplos e casos 
práticos do dia-a-dia do projetista 
de circuitos digitais.
Destina-se a estudantes, profes­
sores, mestrandos e doutoran­
dos, técnicos, autodidatas e 
profissionais da área.

novasaber
www.novasaber.com.br

http://www.sabereletronica.com.br
http://www.microsoft.com
http://www.dev.widows.com
http://www.visuals-tudio.com
http://www.novasaber.com.br
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Projete um
Robô com o LabVIEW

NIRo, uma plataforma de de­

monstração criada por engenheiros 
da National Instruments, é um 
pequeno veículo terrestre não tri­

pulado que utiliza componentes de 
prateleira comprados em uma loja 
comum. O sistema de controle é 
implementado em uma plataforma 
embarcada NI Single-Board RIO que 
contém um FPGA integrado e um 
processador Real-Time.

Guilherme Kenji Yamamoto 
Renan Machado de Azevedo 

National Instruments

Visão geral dos 
componentes

A plataforma NIRo necessita de vários 
componentes de hardware para efetiva­
mente navegar em um ambiente e evitar 
obstáculos:

• Controlador Embarcado: para 
aquisição de dados via sensores, 
tomada de decisão e controle do 
motor;

• Sensores Infravermelhos: para 
detectar objetos dentro de uma 
certa distância em ambos os lados 
e na parte traseira da plataforma 
do robô;

• Sensores Ultrassônicos: para de­
tectar objetos na frente do robô, 
porque ele cobre uma grande área;

• Pontes H: para direcionar a cor­
rente da bateria para o motor e 
mover o eixo do motor para frente 
e para trás.

A figura 1 mostra onde cada com­
ponente do hardware está instalado no 
NIRo. A tabela 1 fornece uma lista deta­
lhada dos componentes.

Visão geral do sistema
A arquitetura de software do NIRo usa 

tanto controle de baixo quanto o de alto 
nível. Tarefas de alto nível, como evitar 
obstáculos e interpretação dos dados dos 
sensores são executadas no processador 
Real-Time embarcado. O algoritmo para 
evitar obstáculos utiliza os dados dos 
sensores infravermelho e ultrassônicos 
para tomar decisões sobre como navegar 
pelo ambiente.

O NIRo também possui um controle 
dos motores de baixo nível, que é imple­
mentado no FPGA. Dependendo da saída 
do algoritmo para evitar obstáculos, o 
FPGA gera um sinal PWM (pulse width 
modulation) nas linhas de entrada e saída 
para controlar os motores. Os dados são 

transferidos entre o processador real-time 
e o FPGA utilizando as funções para 
interface FPGA existentes no LabVIEW.

Os componentes principais da arqui­
tetura de software do NIRo’s incluem:

• Algoritmo para Evitar Obstáculo;
• Controle do Motor (PWM).
A arquitetura de software do NIRo 

é mostrada na figura 2. Os sensores in­
fravermelhos são conectados aos canais 
analógicos integrados do dispositivo NI 
Single-Board RIO, e os sensores ultras- 
sônicos são conectados às linhas digitais 
também integradas no dispositivo. Os 
motores são conectados às pontes H, 
que estão conectadas ao dispositivo NI 
Single-Board RIO utilizando entradas e 
saídas digitais.

Evitar obstáculos
Para evitar obstáculos, o NIRo monito­

ra os valores dos sensores infravermelho 
e ultrassônico. Se os valores lidos nos 
sensores indicam que algo está próximo a 
ele, o NIRo vira a uma taxa proporcional 
à distância que o obstáculo está do robô. 
Em outras palavras, quanto mais próximo 
está o obstáculo do NIRo, mais rápido ele 
desvia deste.

F1. Diagrama do hardware 
do NIRo.
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Isso é ilustrado pelo diagrama de 
blocos de controle na figura 3. Há uma 
distância mínima desejada entre os objetos 
e o NIRo. O robô deve desviar de qualquer 
objeto que esteja mais próximo do que a 
distância mínima. A diferença proporcio­
nal entre a distância mínima desejada e a 
distância atual medida pelos sensores é 
utilizada pelo robô.

O código implementado para evitar 
obstáculo é mostrado na figura 4. Perceba 
que, da mesma forma que na figura 3, a 
distância atual entre objeto e o NIRo é com­
parada à distância mínima desejada entre 
os objetos e o NIRo. Perceba também que 
o algoritmo dentro da estrutura na figura 
4 é similar ao bloco Evitar Obstáculos na 
figura 3. A saída do PID.vi é então usada 
para enviar os comandos dos motores, o 
que faz com que o NIRo desvie do obstá­
culo mais próximo.

Controle do motor (PWM)
A saída do algoritmo para evitar obs­

táculos controla o duty cycle (ciclo de tra­
balho) do sinal PWM para cada motor. Por 
exemplo, se o NIRo não detecta qualquer 
obstáculo em seu caminho, ele envia dados 
para o FPGA, que informa o motor para se 
mover para frente. Isto é obtido ao enviar 
o mesmo duty cycle para os dois motores. 
Se o NIRo precisa virar, o duty cycle é di­
ferente para cada um dos motores.

Os comandos do duty cycle são en­
viados do processador Real-Time para 
o FPGA, os comandos do duty cycle são 
transformados em comandos digitais para 
as pontes H. Cada ponte H utiliza quatro 
sinais digitais e a combinação destes sinais 
digitais direciona a corrente da bateria para 
o motor. Dependendo dos sinais digitais 
enviados para a ponte H, o motor vira 
para frente ou para trás, ou simplesmente 
não se move.

Conclusão
Embora o NIRo seja um robô terrestre 

de pequena escala, ele utiliza os mesmos 
sensores, algoritmos e técnicas comuns 
usados em robôs maiores e mais com­
plexos. Com o LabVIEW Real-Time, o 
LabVIEW FPGA e o NI Single-Board RIO, 
os desenvolvedores podem facilmente 
integrar hardware e software, e rapida­
mente projetar, desenvolver e implementar 
algoritmos.

Algoritmos de decisão de alto nível 
e algoritmos de controle do motor de 
baixo nível podem ser implementa­
dos utilizando uma única plataforma. 
Integrando ferramentas de hardware

disponíveis comercialmente e usando 
uma linguagem de programação gráfica 
de alto nível, pode-se reduzir em muito 
a complexidade de desenvolver um robô 
autônomo. E

F2. A arquitetura de software do NIRo’s implementada 
______________ na plataforma no NI Single-Board RIO.

F3. Diagrama do bloco de controle 
para Evitar Obstáculo.

F4. Código do LabVIEW para 
Evitar Obstáculo.

Parte do Robô I Fabricante Modelo
Controlador embarcado National Instruments |sbRIO-9632

Plataforma Robotics Connection Traxster TM

SensorIF Sharp ¡GP2D12

Ultrassônico Devantech
¡SRF05

Ponte H Solutions Cubed Simples Ponte H ^KUnFRtOm
Componentes.
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Aprenda como projetar
um sistema de controle:
Resposta em frequência para sistemas de controle

Este artigo mostra como plotar a resposta em frequência de um sistema, 
usando o LabVIEW e o módulo LabVIEW Control Design and Simulation. O 
link para download do software NI LabVIEW, do módulo Control Design and 
Simulation e dos VIs, pode ser encontrado no final deste artigo.

Dawn Tilbury 
Bill Messner 

Guilherme K. Yamamoto 
Gustavo L. Peixinho 

Renan M. Azevedo 
National Instruments

Resposta em frequência
O método de resposta em frequência 

pode ser menos intuitivo do que outros 
métodos que você estudou anteriormente. 
Entretanto, ele possui certas vantagens, 
especialmente em situações da vida real 
como, por exemplo, na modelagem de 
funções de transferência a partir de dados 
físicos.

A resposta em frequência é uma 
representação da resposta do sistema a 
entradas senoidais a frequências varian­
tes. A saída de um sistema linear a uma 
entrada senoidal é uma senoide com a 
mesma frequência, mas com magnitude e 
fase diferentes. A resposta em frequência é 
definida como as diferenças de magnitude 
e fase entre as senoides de entrada e saída. 
Neste tutorial, veremos como podemos 
usar a resposta em frequência em malha 
aberta de um sistema para prever o seu 
comportamento em malha fechada.

Para mapear a resposta em frequência, 
criamos um vetor de frequências (varian­
do de 0 ou DC, a infinito) e calculamos o 
valor da função de transferência da planta 
nessas frequências. Se G (s) é a função 
de transferência em malha aberta de um 
sistema e w é o vetor de frequências, então 
traçamos G (j.w) versus w. Uma vez que 
G (j.w) é um número complexo, pode­
mos plotar tanto sua magnitude quanto 
sua fase (no diagrama de Bode). ou sua 
posição no plano complexo (diagrama 
de Nyquist).

Diagramas de Bode
Como observado acima, um diagrama 

de Bode é a representação da magnitude 
e fase de G (j.w) (onde o vetor de frequ­
ências w contém somente frequências 
positivas).

Abordagem gráfica
com LabVIEW

Para ver o diagrama de Bode de 
uma função de transferência, você pode 
usar o VI CD Bode, localizado na sessão 
Frequency Response, da paleta Control 
Design. Veja a figura 1.

Abordagem com
LabVIEW MathScript

Alternativamente, você pode usar o 
código de arquivo m a seguir na janela 
MathScript (Tools » MathScript Window):

num = 50;
den = [1 9 30 40];
sys = tf(num,den);
bode(sys)

Resultado
Com qualquer uma das abordagens, 

exibimos a função de transferência e os 
diagramas de Bode para o sistema. A 
figura 2 mostra o painel frontal do VI 
que foi construído na figura 1. Altere os 
termos no numerador e denominador 
para observar o efeito nos diagramas de 
Bode do sistema.Observando os eixos dos
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gráficos na figura 2, a frequência está em 
um escala logarítmica, a fase está dada 
em graus, e a magnitude está dada con­
forme o ganho em decibéis. Um decibel 
é definido como:

20logl0(G(ja>))

Margens de ganho 
e de fase

Digamos que tenhamos o sistema 
dado, a seguir, na figura 3. No sistema, 
k é um ganho variável (constante) e G (s) 
é a planta a ser considerada. A margem 
de ganho é definida como a variação no 
ganho em malha aberta necessária para 
tornar o sistema instável. Sistemas com 
margens de ganho elevadas podem resis­
tir a mudanças maiores nos parâmetros 
antes de se tornarem instáveis em malha 
fechada. Tenha em mente que o ganho 
unitário em magnitude é igual a um ga­
nho zero em dB.

A margem de fase é definida como 
a variação no deslocamento de fase em 
malha aberta necessária para tornar um 
sistema em malha fechada instável. A 
margem de fase também mede a tole­
rância do sistema a atrasos de tempo. Se 
houver um atraso de tempo maior que 
180/wpc na malha (onde wpc é frequência 
onde o deslocamento de fase é 180 graus), 
o sistema se tornará instável em malha 
fechada. O atraso de tempo pode ser pen­
sado como um bloco extra no caminho de 
ida do diagrama de blocos que adiciona 
fase ao sistema, mas não possui efeito no 
ganho. Ou seja, um atraso de tempo que 
pode ser representado como um bloco 
com magnitude 1 e fase w* atraso de 
tempo (em radianos/segundo).

Neste momento, não nos preocupa­
remos em saber de onde tudo isso vem 
e nos concentraremos em identificar as 
margens de ganho e de fase em um dia­
grama de Bode.

A margem de fase é a diferença em 
fase entre a curva de fase e -180 graus, no 
ponto correspondente à frequência que 
nos dá um ganho de 0 dB (o ganho cruza 
a frequência, wgc). Do mesmo modo, a 
margem de ganho é a diferença entre 
a curva de magnitude e 0 dB no ponto 
correspondente à frequência que nos da 
uma fase de -180 graus (a fase cruza a fre-

quência, wpc). Atente para a figura 4. Uma 
coisa boa sobre a margem de fase é que 
você não precisa refazer o diagrama de 
Bode a fim de encontrar a nova margem 
de fase ao alterar os ganhos. Se você re­
lembrar, adicionar ganho somente desloca 
o gráfico da magnitude para cima. Isso é o 
equivalente a alterar o eixo y no gráfico da

F1. Criando um diagrama 
de Bode.

F2. Diagramas de Bode 
no LabVIEW.

F3. Um sistema em 
malha fechada.

magnitude. Encontrar a margem de fase é 
simplesmente a questão de entrar a nova 
frequência cruzada e ler a margem de fase.

Para observar este efeito, primeiro 
olhe os diagramas de Bode na figura 4. 
Você deve ver que a margem de fase é 
cerca de 100 graus. Agora suponha que 
você adicione um ganho de 100.
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Abordagem gráfica 
com LabVIEW

Para fazer isso em um VI, adicione um 
segundo VI CD Construct Transfer Function 
Model ao seu diagrama de blocos da figura 
1. Crie uma entrada de constante ao terminal 
do numerador e insira 100 na primeira célula 
deste array. A seguir, adicione o VI CD Series 
ao diagrama de blocos (da sessão Model 
Interconnection da paleta Control Design) 
e conecte ambos os modelos de função de 
transferência às entradas do VI CD Series. 
Conecte a saída Series Model do VI CD 
Series aos VIs CD Bode e CD Draw Transfer 
Function como anteriormente.

Observe a figura 5.

Abordagem com
LabVIEW MathScript

Se você utilizou código de arquivo m 
para modelar o sistema, insira o comando 
bode(100*sys) na janela MathScript.

Resultado
Depois de adicionar um ganho de 100, você 

deve ver os diagramas ilustrados na figura 6. 
Como você pode notar, o diagrama de fase é 
exatamente o mesmo de antes, e o diagrama 
de magnitude está deslocado para cima em 40 
dB (ganho de 100). A margem de fase agora é 
cerca de -60 graus. Este mesmo resultado po­
deria ser alcançado se o eixo y do diagrama de 
magnitude fosse deslocado 40 dB para baixo. 
Para confirmar isso, veja os diagramas de Bode 
na figura 4, encontre onde a curva cruza a linha 
de -40 dB, e leia a margem de fase. Ela deve ser 
cerca de -60 graus, a mesma que nos diagramas 
de Bode na figura 6.

Podemos também encontrar as mar­
gens de ganho e de fase diretamente no 
LabVIEW.

Abordagem gráfica 
com LabVIEW

Usando o VI da figura 1, substitua o 
VI CD Bode com o VI CD Gain and Phase 
Margin, encontrado na sessão Frequency 
Response da paleta Control Design. Crie 
indicadores para os terminais Magnitude 
Plot, Phase Plot e Gain and Phase Margins. 
Acompanhe na figura 7.

Abordagem com
LabVIEW MathScript

Alternativamente, você pode usar o 
comando margin na janela MathScript.

Este comando retorna as margens de 
ganho e fase, as frequências dos inter- 
ceptos do ganho e da fase e uma repre­
sentação gráfica deles no diagrama de 
Bode. Se você utilizou código de arquivo 
.m para modelar o sistema, insira o se­
guinte comando na janela MathScript: 
margin(sys)

Resultado
Traçar as margens de ganho e fase 

retorna os gráficos mostrados na figura 8.

F4. Margens de 
ganho de fase.

F5. Diagrama de Bode de 
um sistema com ganho.

Frequência de 
largura de banda

A frequência de largura de banda é 
definida como a frequência na qual a res­
posta em magnitude em malha fechada é 
igual a -3 dB. Entretanto, quando projeta­
mos via resposta em frequência, estamos 
interessados em prever o comportamento 
em malha fechada a partir da resposta 
em malha aberta. Portanto, usaremos 
uma aproximação de sistema de segun­
da ordem e diremos que a frequência de
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F6. Diagramas de Bode 
com ganho de 100.

Primeiro, vamos encontrar a frequ­
ência de largura de banda observando o 
diagrama de Bode (para fazer isso, utilize 
o VI construído na figura 1, ou o código 
MathScript correspondente). Figura 9.

Uma vez que essa é a função de 
transferência em malha fechada, a nossa 
frequência de largura de banda será a 
frequência correspondente a um ganho de 
-3 dB. Observando o diagrama, veremos 
que ela é aproximadamente 1,4 rad/s. 
Podemos também ler a partir do diagra­
ma que para uma frequência de entrada 
de 0,3 radianos, a senoide de saída tem 
uma magnitude de aproximadamente 
um e a fase deve ser deslocada em al­
guns graus (para trás da entrada). Para 
uma frequência de entrada de 3 rad/s, a 
magnitude da saída deve ser cerca de 20 
dB (ou 1/10 da entrada) e a fase deve ser 
aproximadamente -180 (quase exatamente 
fora de fase).

Primeiramente, considere uma entra­
da senoidal com uma frequência menor 
que "bw.

largura de banda é igual à frequência na 
qual a resposta em magnitude em malha 
aberta é entre -6 e -7,5 dB, assumindo que 
a resposta em fase em malha aberta está 
entre -135 e -225 graus.

Com o objetivo de ilustrar a impor­
tância da frequência de largura de banda, 
mostraremos como a saída varia com 
diferentes frequências de entrada. Obser­
varemos que entradas senoidais com fre­
quências menores que "bw (a frequência 
de largura de banda) são acompanhadas

F7. Margem de fase e de 
ganho no LabVIEW.

“razoavelmente bem” pelo sistema. En­
tradas senoidais com frequência maior 
que wbw são atenuadas (em magnitude) 
de um fator de 0,707 ou mais (e também 
são deslocadas em fase).

Digamos que temos a seguinte função 
de transferência em malha fechada repre­
sentando um sistema:

Abordagem gráfica 
com LabVIEW

Podemos usar um Simulation Loop 
(da paleta Simulation) para simular a 
resposta do sistema a entradas senoidais. 
Utilize o diagrama de blocos exibido na 
figura 10 para construir este sistema.

Abordagem com o LabVIEW 
MathScript

Alternativamente, podemos utilizar o 
comando lsim na janela MathScript para 
chegar no mesmo resultado.

w = 0.3;
num = 1;
den = [1 0.5 1];
sys = tf(num,den);
t = 0:0.1:100;
u = sin(w*t);
[y,t] = lsim(sys,u,t);
plot(t,y,t,u)

Resultado
Devemos ter em mente que quere­

mos visualizar a resposta em regime 
estacionário. Portanto, ignoramos a 
resposta transitória quando olhamos 
para estes diagramas. Veja a figura 11. 
Observe que a saída (branco) segue a k
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F8. Margens de 
ganho e fase.

entrada (vermelho) muito bem; ela está 
talvez alguns graus atrás da entrada 
como esperado.

Entretanto, se colocarmos a frequência 
da entrada mais alta que a frequência de 
largura de banda para o sistema, obtere­
mos uma resposta muito distorcida (com 
relação à entrada). Observe os efeitos da 
variação da frequência de 0,3 a 3.

Abordagem gráfica 
com LabVIEW

Aumente a frequência do sinal de en­
trada para 3, usando o controle do painel 
frontal do seu VI.

Abordagem com o LabVIEW 
MathScript

Insira o código a seguir na janela 
MathScript:

w = 3;
num = 1;
den = [1 0.5 1];
sys = tf(num,den);
t = 0:0.1:100;
u = sin(w*t);
[y,t] = lsim(sys,u,t);
plot(t,y,t,u)
axis([90, 100, -1, 1])

F9. Diagramas 
de Bode.
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F10. Simulação linear 
no LabVIEW.

F11. Simulação linear 
de um sistema.

F12. Simulação linear de 
______ um sistema, ^=3.
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I F13. Um sistema em 
malha fechada.

F14. Diagramas 
de Bode.

F15. Encontrando a constante para 
______ erro de regime estacionário.

Resultado
Novamente, observe que a magnitude 

é cerca de 1/10 da magnitude da entrada, 
como previsto, e que está quase exatamente 
fora de fase (180 graus atrás) com a entrada. 
Sinta-se à vontade para experimentar e vi­
sualizar a resposta para várias frequências 
diferentes e veja se elas condizem com o 
diagrama de Bode. Atente para a figura 12.

Desempenho em 
malha fechada

Com o intuito de prever o desempe­
nho em malha fechada a partir da resposta 
em frequência em malha aberta, precisa­
mos ter vários conceitos esclarecidos:

• O sistema deverá ser estável em 
malha aberta, se formos projetar 
via diagramas de Bode;

• Se o intercepto do ganho com a 
frequência for menor do que o in­
tercepto entre a fase e a frequência 
(wgc < wpc), então o sistema em malha 
aberta será estável;

• Para sistemas de segunda ordem, a 
taxa de amortecimento em malha 
fechada é aproximadamente igual 
à margem de fase dividida por 100 
se a margem de fase estiver entre 
0 e 60 graus. Poderemos usar este 
conceito com atenção, se a margem 
de fase for maior que 60 graus;

• Uma estimativa muito grosseira 
que você pode usar é que a largura 
de banda é aproximadamente igual 
à frequência natural.

Vamos usar esses conceitos para 
projetar um controlador para o sistema 
mostrado na figura 13.

Neste sistema, Gc (s) é o controlador, 
e G (s) é:

10 
1,255+1

O projeto deve atender às seguintes 
especificações:

• Erro de regime estacionário: nulo;
• O overshoot máximo deve ser me­

nor que 40%;
• O tempo de estabelecimento deve 

ser menor que 2 segundos.
Há dois modos de resolver este proble­

ma: um é gráfico e o outro é numérico. No 
LabVIEW, a abordagem gráfica é melhor,
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então esta será a abordagem que usare­
mos. Primeiro, vamos olhar o diagrama 
de Bode. Use o VI da figura 1 (ou a janela 
MathScript) para desenhar os diagramas 
de Bode para a função de transferência 
acima. Acompanhe na figura 14.

Há várias características do sistema 
que podem ser lidas diretamente no 
diagrama de Bode. Primeiro de tudo, 
podemos ver que a frequência de largura 
de banda é cerca de 10 rad/s. Uma vez 
que a frequência de largura de banda é 
grosseiramente a mesma que a frequên­
cia natural (para um sistema de primeira 
ordem deste tipo), o tempo de subida é 
1,8/BW =1,8/10 = 1,8 segundos. Isso é uma 
estimativa grosseira, então diremos que o 
tempo de subida é cerca de 2 segundos.

A margem de fase para esse sistema 
á aproximadamente 95 graus. A relação 
taxa de amortecimento = (margem de 
fase)/100 somente é válida para mar­
gens fase de abaixo de 60 graus. Uma 
vez que o sistema é de primeira ordem, 
não deve haver overshoot.O último 
ponto principal de interesse é o erro de 
regime estacionário. Este erro também 
pode ser lido diretamente no diagrama 
de Bode. A constante (KP, KV ou KA) é 
encontrada a partir da intersecção da 
assíntota da frequência baixa com a 
linha w=1. Apenas prolongue a linha 
da baixa frequência até a linha m=1. A 
magnitude neste ponto é a constante.

F16. Resposta ao degrau 
usando realimentação.

F17. Resposta ao degrau, 
sem controlador.

F18. Sistema com 
controlador PI.
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Uma vez que o diagrama de Bode desse 
sistema é uma linha horizontal a baixas 
frequências (inclinação = 0), sabemos 
que este sistema é do tipo zero. Portanto,

a intersecção é fácil de ser encontrada. 
O ganho é de 20 dB (magnitude 10). O 
que isso significa é que a constante para 
a função de erro é 10.

F19. Controlador PI com 
diagramas de Bode.

F20. Efeito de um controlador 
PI com um zero em 1.

O erro de regime estacionário para 
este sistema é:

i/U+k^i/Çi+ioM.oçi

Se o nosso sistema fosse do tipo um 
em vez do tipo zero, a constante para o 
erro de regime estacionário deve ser encon­
trada em uma maneira similar à seguinte 
(figura 15).

Vamos conferir as nossas previsões 
olhando um gráfico de resposta ao degrau.

Abordagem gráfica 
com LabVIEW

Isso pode ser feito no LabVIEW usan­
do o VI CD Step Response (da sessão 
Time Response da paleta Control Design), 
junto com o VI CD Feedback. Observe a 
figura 16.

Abordagem com
LabVIEW MathScript

Alternativamente, você pode adi­
cionar duas linhas de código na janela 
MathScript:

sys_cl = feedback(sys,1);
step(sys_cl)

Resultado
O gráfico resultante é mostrado na 

figura 17, a seguir.
Como você pode ver, as nossas previ­

sões foram muito boas. O sistema possui um 
tempo de subida de cerca de 2 segundos, 
não possui overshoot e tem um erro de 
regime estacionário de cerca de 9%. Agora 
precisamos selecionar um controlador que 
nos permitirá atender aos critérios do proje­
to. Escolheremos um controlador PI porque 
ele produzirá erro de regime estacionário 
nulo para uma entrada de degrau. Ainda 
mais, o controlador PI possui um zero que 
podemos posicionar. Isso nos dá flexibi­
lidade adicional de projeto para atender 
aos nossos critérios. Lembre-se de que um 
controlador PI é dado por Gc(s) = [K(s+a)] / s.

A primeira coisa que precisamos en­
contrar é a taxa de amortecimento corres­
pondente a um percentual de overshoot 
de 40%. Colocando este valor na equação 
que relaciona o overshoot e a taxa de 
amortecimento (ou consultando um gráfi-
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co dessa relação), descobrimos que a taxa 
de amortecimento para esse overshoot é 
aproximadamente 0,28. Portanto, a nossa 
margem de fase deve ser no mínimo 30 
graus. A partir da equação que relaciona 
Ts . wbw à taxa de amortecimento, encon­
tramos que Ts. wbw 21. Devemos ter uma 
frequência de largura de banda maior ou 
igual a 12 se quisermos que o nosso tempo 
de estabelecimento seja menos que 1,75 
segundos, o que atende às especificações 
de projeto.

Agora que sabemos a nossa margem 
de fase e frequência de largura de banda 
desejada, podemos começar o nosso pro­
jeto. Lembre-se de que estamos olhando 
para os diagramas de Bode em malha 
aberta. Portanto, nossa frequência de 
largura de banda será a frequência cor­
respondente a um ganho de aproxima­
damente -7 dB. Vejamos como a porção 
do integrador do controlador PI afeta a 
nossa resposta.

Abordagem gráfica
com LabVIEW

Para fazer isso, crie modelos de siste­
mas para a planta e para controlador PI. 
Conecte esses modelos em série com o 
VI CD Series, e construa os diagramas de 
Bode para o modelo resultante usando o 
VI CD Bode. Figura 18.

Abordagem com
LabVIEW MathScript

Alternativamente, você pode usar 
código textual na janela MathScript para 
modelar o sistema. Altere o seu código 
para adicionar um termo integral, mas 
nenhum termo proporcional.

num = 10;
den = [1.25 1];
plant = tf(num,den);
numPI = 1;
denPI = [1 0];
contr = tf(numPI,denPI);
bode(contr * plant, logspace(0,2))

Resultado
O painel frontal que resulta do VI 

na figura 18 está mostrado a seguir, na 
figura 19.

Dos gráficos aqui ou do MathScript, 
vemos que a nossa margem de fase e frequ­
ência de largura de banda são muito baixas.
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Projetos

Adicionaremos ganho e fase com um 
zero. Vamos colocar o zero em 1 no mo­
mento, e ver o que acontece.

Abordagem gráfica 
com LabVIEW

Altere o os controles do painel frontal 
do seu VI de forma que os termos de Nu­
merator 2 sejam 1,1.

Abordagem com o
LabVIEW MathScript

Modifique o seu código para ficar 
semelhante ao seguinte:

F22. Resposta ao degrau 
do controlador PI.

num = 10;
den = [1.25 1];
plant = tf(num,den);
numPI = [1 1];
denPI = [1 0];
contr = tf(numPI,denPI);
bode(contr * plant, logspace(0,2))

Resultado
Acompanhe na figura 20. Acontece 

que o zero em 1 com um ganho unitário 
nos dá uma resposta satisfatória. A nossa 
margem de fase é maior que 60 graus 
(até menos overshoot que o esperado) e 

a nossa frequência de largura de banda 
é aproximadamente 11 rad/s, o que nos 
dá uma resposta satisfatória. Embora 
satisfatória, a resposta não está tão boa 
quanto gostaríamos.

Portanto, vamos tentar conseguir uma 
frequência de largura de banda maior sem 
alterar muito a margem de fase. Vamos 
tentar aumentar o ganho para 5 e ver o 
que acontece. Isso fará com que o ganho 
se desloque e a fase continuará a mesma.

Abordagem gráfica 
com LabVIEW

Altere os controles do seu VI de forma 
que os termos de Numerator 2 sejam 5, 5.

Abordagem com
LabVIEW MathScript

Se você estiver usando a janela MathS­
cript, altere o numerador do controlador 
usando o comando numPI = 5*[1 1], no 
lugar do comando que foi usado ante­
riormente.

Resultado
Isso parece realmente bom. Vamos ver 

a nossa resposta ao degrau e verificar os 
nossos resultados. Observe a figura 21.

Abordagem gráfica 
com o LabVIEW

Como fizemos na figura 16, criamos 
um sistema com um numerador de 1 e 
adicionamos o VI CD Feedback e o VI 
CD Step Response ao nosso diagrama 
de blocos.

Abordagem com o
LabVIEW MathScript

Alternativamente, podemos adicionar 
as duas linhas a seguir à janela MathS­
cript:

sys_cl = feedback(contr * plant,1);
step(sys_cl)

Resultado
Como você pode ver, a nossa resposta 

é melhor do que esperávamos (figura 
22). Entretanto, nem sempre temos essa 
sorte e normalmente precisamos alterar 
o ganho e a posição dos polos e/ou zeros 
a fim de alcançar os requisitos do nosso 
projeto. E
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I Componentes

Controladores Step-Down Duplos 
com entrada de referência externa alcançam 
uma precisão de regulação de 0,3%

Sistemas de baixa tensão/alta 
corrente requerem uma regulação 
diferencial de precisão. Eles não são 
incomuns tendo tensão de alimenta­

ção de 0,9 V ou menos, demandando 
correntes de 25 A ou mais, e sofrendo 
o impacto de transientes rápidos que 
provocam curtos elétricos intermi­

tentes na fonte de alimentação. Tais 
sistemas exigem uma precisão na 
regulação da fonte menor que 1% 
da tensão DC regulada, ou menor 
que 3% em razão dos transientes na 
entrada.

 Shuo Chen e Terry Groom
Tradução/Adaptação: Eutíquio Lopez

P
rocessadores “core” e outros CIs 
digitais como ASICs e FPGAs 
exigem, cada vez mais, o escalo­
namento da tensão dinâmica para 
liberar potência com base na demanda do 

processador. O objetivo é que o sistema 
possa reter a alimentação aplicada com 
um mínimo de tensão necessária para 
uma operação adequada, baseada na 
demanda do processamento para con­
servar a energia. Um exemplo disso é o 
AVSO - "LSI's adaptive voltage scaling 
& optimization”.

O CI LTC3838-2 foi projetado para 
possuir requisitos de precisão extremos 
através do sensoriamento da saída dife­
rencial de precisão, oferecendo escalona­
mento da tensão dinâmica de saída com 
o uso da entrada de tensão de referência 
externa diferencial.

Veja as principais características de 
precisão de regulação dos LTC3838-1 e 
-2 na tabela 1.

A precisão da VOUT diferen­
cial dupla é o que importa!

Para alcançar uma precisão de regula­
ção superior, muitas vezes os projetistas 

de fontes de alimentação evitam usar o 
amplificador com erro interno do contro­
lador e, ao invés disso, usam uma referên­
cia discreta de precisão e amplificadores 
operacionais externos para controlar o 
estágio de potência. O problema é que o 
soft-start e muitas características comuns 
de controle de falhas, como a proteção 
contra sobretensão, podem ser sacrifica­
das em função da técnica utilizada.

O LTC3838-2 contorna essa dificul­
dade, uma vez que permite o emprego 
de uma referência externa de precisão 
enquanto preserva valiosas características 
de proteção contra falhas. Com uma refe­
rência de tensão de precisão (tal como a 
LTC6652, da Linear Technologies), ou um 
DAC programável, a saída do canal 2 do 
regulador pode ser regulada firmemente 
desde 0,4 V até 5,5 V em aplicações com 
correntes até 25 A por canal.

Para um nível de tensão muito baixo 
como, por exemplo, 0,6 V, o LTC3838-2 é 
capaz de alcançar uma precisão combina­
da total de ± 4 mV (ou 0,67%) em todas as 
condições de funcionamento, incluindo: 
linha, carga, temperatura externa, e desvio 
de terra remoto de até ± 200 mV.

REMOTELY-SENSED 
POWER GROUND 1, 
t500mV MAX vs SGND

'OUTSENSE1

'bUTSENSET

LTC3838-2

VOUT2'

rDFB1

RDFB3=
RDFB1//RDFB2 -200mV MAX vs SGND

REMOTELY SENSED
EXTERNAL
REFERENCE GROUND

VOUT2 
REMOTELY SENSED 
POWER GROUND 2

ÇOUT2 to PROGRAM 

VOUT2=VreF2 
REMOVE RDFB 

AND USE
RDFB3=RDFB2

F1. O canal 2 do LTC3838-2 regula uma referência externa; o canal 
1 uma referência interna. VOUT1 e VOUT2 admitem terras remo­

tos até ± 500 mV e ± 200 mV, respectivamente.
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*external resistor divider error not included

I Part Number I Reference Voltage Output Voltage
LTC3838-1 /-1 Ch.1 and LTC3838-1
Ch.2

0.6V Internal 0.6 V to 5.5 V

LTC3838-2 Ch.2 (e.g., with ± 0.1% Line-
0.6 V External 0.6 V to 5.5 V

1.5 V External 1.5 V to 5.5 V
ar Technology Voltage References)

2.5 V External 2.5 V to 5.5 V

< ± 0.75% (0°C < TA < 85°C)
< ± 1% (-40°C < TA < 125°C)

< ± 0.67% (-40°C < TA < 125°C)

< ± 0.4% (-40°C < TA < 125°C)

< ± 0.3%

Total combined accuracy (ground, line, load & temp)*

T1. Precisão da regulação 
da tensão de saída.

DTR1
DTR2

RT PHASMD 
MODE/PLLIN

SGND CLKOUT

RUN1 RUN2

F2. Um conversor duplo, em 300 kHz, 
o LTC3838-2 com um sensor “indutor- 

DCR” Esta aplicação converte uma 
entrada (4,5 V a 14 V) em uma saída 
dinâmica de 0,4 V a 2,5 V com 50 A.
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A precisão relativa melhora com o 
incremento da referência porque o erro 
absoluto é uma porcentagem menor 
fora de uma tensão de referência maior. 
Isso contrasta com a programação da 
tensão de saída pela realimentação do 

F3. Gráfico de Bode - Ganho e Fase - em malha aberta e malha 
fechada, traçados com um Lab Network Analyser OMICRON 
sobre VOUT2 de um conversor LTC3838-2, em 350 kHz, com 

uma referência externa (EXTVREF2).

escalonamento com relação a uma menor 
tensão de referência fixada, onde o erro 
de porcentagem não muda. Por exemplo, 
com uma referência externa de 2,5 V, a 
tolerância relativa total é menor que ± 
0,3%. O LTC3838-2 de dois canais pode

F4. O LTC3838-2 segue a referência externa:
____________ senoide de 3,5 kHz com 1 Vpp. 

ser configurado para aplicações de uma 
saída somente, usando referência externa 
no canal 2 com essa precisão.

Seguindo uma referência 
diferencial externa

Para o sensoriamento de uma referên­
cia diferencial externa, o LTC 3838-2 tem 
somente um pino de entrada de referência 
externa. O canal 2 possui um amplifica­
dor realimentado único, o que elimina a 
necessidade de um pino separado para 
sensoriamento do terra remoto da refe­
rência externa. Em vez disso, é utilizado 
um resistor adicional equivalente a dois 
resistores de feedback em paralelo para 
conectar o terra remoto externamente. 
Veja a figura 1.

Consulte o data sheet do LTC3838-2 
para entender como essa configuração 
trabalha.

A figura 2 mostra uma aplicação típica 
com o LTC3838-2 usando uma entrada 
de referência externa. Esse conversor de 
2 fases é capaz de fornecer 50 A sobre 
uma ampla faixa de saída, que vai desde 
0,4 V até 2,5 V. Assim sendo, com 1,5 V, 
esse circuito pode alcançar uma precisão 
combinada (total) de 0,4% em todas as 
condições de operação. A alta precisão 
e performance superior para transien­
tes tornam o LTC3838-2 preferido para 
atender a maioria das aplicações com 
“processadores de alta corrente de saída”.

Ademais da precisão de regulação, 
o CI oferece seguimento de uma ampla 
largura de banda para uma referência 
externa dinâmica, o que é importante 
em aplicações com o escalonamento da 
tensão dinâmica porque a largura de 
banda determina o quão rapidamente a 
alimentação pode responder às mudanças 
na referência externa programada.

A figura 3 ilustra os gráficos de Bode 
de um conversor step-down LTC3838-2, 
em 350 kHz, compensado para uma lar­
gura de banda ativa de 1/3 da frequência 
do chaveamento sem sacrifício da estabili­
dade. Isso permite que o CI siga uma onda

Each per channel

I PART 1 VRNG = SGND 1 VRNG = INTVCC 1 VRNG CONTROL

LTC3838 and LTC3839 21 mV to 40 mv 39 mV to 61 mV 30 mV - 200 mV continuous & 30 mV/50 mV fixed

LTC3838-1 24 mV to 36 mV 54 mV to 69 mV 30 mV/60 mV fixed

LTC3838-2 24 mV to 36 mV 30 mV fixed only

single

no

VRNG (PIN(S)

T2. Especificações 
máximas.
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senoidal externa de 3,5 kHz ou 1/100 da 
frequência de chaveamento com potência 
total, sem distorção significativa mesmo 
nos instantes de partida e interrupção da 
senoide (figura 4).

Uma atenção cuidadosa deve ser to­
mada quanto aos requisitos de largura de 
banda para qualquer sistema dinâmico. A 
grande capacidade de seguimento da re­
ferência externa com banda larga, somada 
a um bom desempenho com transientes 
muito rápidos, tornam o LTC3838-2 como 
o mais cotado para uso na maioria das 
aplicações de alimentação dinâmica.

Controlador LTC3838-1: 
Referência interna em ambos 
canais

O LTC 3838-1 compartilha as mesmas 
funções que o LTC3838-2, exceto que o 
canal 2 do primeiro usa uma referência 
interna de 0,6 V. Igual aos seus anteces­
sores (LTC3838 e LTC3839), ambos -1 e -2 
utilizam on-time controlado, arquitetura 
em modo corrente (de vale), que oferece 
regulação superior durante rápidos tran­
sientes de carga sem o típico atraso da 
resposta no período de chaveamento dos 
controladores de frequência fixa, sendo 
capazes ainda de um chaveamento de 
frequência constante travado para um 
clock externo de 200 kHz a 2 MHz.

Continuando, os LTC3838-1 e -2 man­
têm todas as características do LTC3838, 
incluindo a DTR (detect transient release) 
proprietária, a qual melhora o desempe­
nho para transientes em aplicações com 
baixa tensão de saída. Assim como o 
LTC3838, ambos LTC3838-1 e -2 possuem 
um conjunto completo de características 
conhecidas, entre elas: um pino VCC po­
wer externo, RSENSE ou sensoriamento de 
corrente com indutor - DCR, modos de 
operação com carga leve selecionáveis, 
proteção contra sobretensão e foldback 
limite de corrente, seguimento de soft/ 
start/rail, e pinos de PGOOD e RUN para 
cada canal.

Além do sensoriamento de saída 
remoto diferencial nos dois canais, uma 
melhoria significativa dos LTC3838-1 e 
-2 em relação ao original LTC3838 é a 
máxima precisão da tensão de threshold 
(limiar). Diferentemente do LTC3838, que 
possui dois ranges de corrente fixos (VRGN) 
e um variável continuamente, o LTC 3838- ►
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F5. Quando um “rail” de 5 V externo é disponível para 
aumentar a polarização do controlador, esta aplicação do 

LTC3838-1 converte uma entrada de tensão dinâmica de 3,3 
V a 14 V em uma saída dupla (1,2 V e 0,9 V) com 20 A.

2 tem um VRGN fixo = 30 mV (típico) e sua 
tolerância com a temperatura é de ± 20%, 
que foi muito melhorada.

O LTC3838-1 possui os mesmos 30 mV 
e um setting VRGN adicional de 60 mV cuja 
tolerância também é significativamente 
apertada. Acompanhe na tabela 2 uma 
comparação nas tolerâncias-limites de 
corrente e nos controles VRGN da série 
LTC3838 de controladores duais.

Os controladores LTC3838-1/ -2 re­
querem uma tensão mínima de 4,5 V no 
pino VIN, mas isso não limita a entrada de 
alimentação em 4,5 V. Por exemplo, muitos 

sistemas digitais dispõem de um rail de 
5 V regulados que pode ser usado para 
polarizar o pino VIN e os gate drivers, e para 
entradas de step-down menores que 4,5 V.

A figura 5 mostra o pino VIN ligado 
via diodo-OR em VBIAS = 5 V e em PO­
WER VIN (3,3 - 14 V). Isso permite que 
POWER VINchaveie dinamicamente entre 
um mínimo de 3,3 V e uma tensão mais 
alta. Quando funcionando com a alimen­
tação de POWER VIN abaixo de 5,5 V, a 
aplicação exige que a VBIAS supply esteja 
presente em EXTVCC de modo a manter 
as tensões DRVCC, INTVCC e no pino VIN 

nos níveis necessários para que o CI opere 
adequadamente. A alimentação EXTVCC 
é opcional, quando POWER VIN supply 
é > a 5,5 V.

Repare que o range de tensão de 
entrada de alimentação desta aplicação 
não pode ser generalizado para outras 
frequências e tensões de saída, e que cada 
aplicação que precise de diferente tensão 
de entrada no pino VIN deverá ser testada 
individualmente para margem de range, 
na qual os nodos de chaveamento (SW1 e 
SW2) travam a fase para a saída de clock 
(CLKOUT). E
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